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1 DISCLAIMER

The present publication is drawn up by way of information only and does not constitute an offer binding upon Daikin Applied
Europe S.p.A. Daikin Applied Europe S.p.A. has compiled the content of this publication to the best of its knowledge. No
express or implied warranty is given for the completeness, accuracy, reliability or fitness for particular purpose of its content
and the products and services presented therein. Specifications are subject to change without prior notice. Daikin Applied
Europe explicitly rejects any liability for any direct or indirect damage, in the broadest sense, arising from or related to the
use and/or interpretation of this publication. All content is copyrighted by Daikin Applied Europe S.p.A.

2 SCOPE AND APPLICATION

knowledge of HVAC equipment, mechanical systems, electrical wiring, controls, & microprocessors.
Attempts by untrained or unauthorized persons to start, operate and service this equipment can result in
equipment failure, personal injury, or death, as well as invalidation of product warranty. It is the responsibility
of the technician to ensure that proper safety equipment safe practices are used.

f The following information are intended only as a guide for authorized Daikin personnel with a sound basic

This document explains how to update software on SIEMENS controller POL 687, POL 638, POL 688, POL 468 of any
Daikin Applied Europe manufactured chiller, heat pump or AHU.

3 DAE SOFTWARE REPOSITORY

All Official Software can be downloaded from the Official Software Repository which can be reached
at the following link: DAE Software Repository

Within the collection, the software’s are provided in zip file, divided by unit name and related software
name.

' DA ’K’N SharePoint A Search this collection

DS DAE Software Repository
Home Official Service Packs Simulator Modification

T Charge ~ B Editing in grid view @ Synchronize B Add to Quick Access K3 Export ~ 3% Automates - & Integrates -

Official Wy~
(] Name Software Name Madification da... Moadified by + Add Column
EWAD-CE AWS May 5, 2021 Massimiliano Amadei
EWAD-D EWAD-E ERAD-E EWAD-T MNG August 13, 2021 Leonardo Verucc
EWAD-TZ EWAH-TZ ALL SERIES ATLAS April 8, 2020 Massimiliano Amadei
EWAQ-E EWAQ-F ACZ-C April 23, 2020 Leonardo Verucci
EWAQ-G EWYQ-G GIZMO April 8, 2020 Massimiliano Amadei

Figure 1 DAE Software Repository
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4 GENERAL UPDATE PROCEDURE CONCEPT

INFORMATION
E] Software update to latest version is not strictly required except that for the following cases:
o New controller spare part replacement
e Required by Service Support department
e Required by RNSQI, DAE Bullettin, ESV and SVI
e Latest software has solution to an on-field issue according to the improvements and bugs fixed
explained in the Change in Operations

INFORMATION
E The software update procedure by SD-Card is also valid for updating the BSP of the controller and extensions.
New BSPs with important changes have been released, it is recommended to update the BSP to the latest
version available from the Official Software Repository
For more information, read the following Service Bulletin:
e DAE SB 18-23/ RNSQI 23-52 Cybersecurity protocol update Siemens boards connected to DOS

e DAE SB 19-23/ RNSQI 23-51 New BSP Release POL 688

Generally, the software update procedure is needed when a newer software version is available with new futures that need
to be implemented on the unit, or in case of controller replacement (new spare part).

Before proceeding with the software update, it is common sense to do all the preparation steps and take all the precaution
necessary to avoid future issue due to of a software update failure.

The most important thing to do before proceeding, is to take notes or/and pictures of the actual software parameters. This
includes all the pages as follows:

Chiller:

e  Commission Unit > Configuration

e Commission Unit > Alarm Limits

e Commission Unit - Sensors Calibration

e View/Set Circuit > Circuit %2 © Compressor = Run Hours and Start

e View/Set Circuit - Circuit %2 - Compressor - Take note of compressor model and frequency in case of
inverter compressor.

e BMS Settings

e Controller IP Settings

AHU (Modular and Professional AirStream SW):

e Commissioning ->AHU Configuration - Config Unit Type

e Commissioning ->AHU Configuration > Config Components
e Commissioning - AHU Configuration - Config Function

e  Status/Settings - Temperature Control

e  Status/Settings >Fans

e  Status/Settings - Sensor Settings

e BMS Settings

e Controller IP Settings

It is important to take note of this settings, other than the Save Parameter Procedure, to have a backup plan in case of
issues due to a failed Save Parameter Procedure.
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INFORMATION
ﬂl In case the restore procedure fails, all the parameters are set as default.

e Chiller: unit, circuit configuration, alarm limits, sensor calibration, compressor run hours and
starts, frequency parameters are anyway possible to update manually.

e AHU: unit, components configuration, function configuration, temperature control, fans,
sensor settings are anyway possible to update manually only in the Air Stream Software, to
update the parameters in the D-Stream Software please contact the Service Support.

In case parameters are lost, refer to service support for correct unit configuration, attaching the
unit serial number.

Once all the preparation work is done, the software update procedure is done typically in 3 steps:

1. Parameter Save: Controller parameters (“PARAM.UCF”) are downloaded from the controller to SD/USB drive

2. Software Update: New software is installed on the controller

3. Parameter Restore: Previously saved parameters (“PARAM.UCF”) are downloaded from SD/USB to the controller
with new software

In the next chapters are explained all these steps one by one for each kind of controller and type of software update.

In the special case when the original controller is damaged, it is impossible to save the original parameters, then a manual
configuration of the software parameters is needed.

Refer to servicesupport@daikinapplied.eu to get the unit configuration parameters to be able to fully configure the new
software manually.

To get correct unit configuration parameters send unit model and unit serial number.
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5 POL 688 (Microtech 4)

5.1 Description

INFORMATION
POL 688 Controllers equipped with mAP, do not have an integrated HMI (Figure 2C)
To perform the software update is required an external HMI, refer to POL895 External HMI
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Figure 2 (A) POL688.80/STD with HMI (B) POL688.80/STD with HMI Additional interfaces on the bottom of the devices
(C) POL688.10/STD without HMI
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Figure 3 a) pin hole b) LED c) T-IP port d) micro-USB port €) SD Card slot

LEDs for diagnostics

BSP BUS

Figure 4 BSP BUS LEDs

e LED BSP “Run/ Stop™ 3 colours (green, red, and orange)

ot ]
SW update mode (download application or firmware) | Every second alternating between red and green
Application running Green on
Application loaded, but not running Orange on
Application not loaded Orange flashes: 50 ms on, 1000 ms off
Firmware error Red blinking at 2 Hz
Hardware fault Red on

Table A LED BSP meaning
e LED BUS: 3 colours (green, red and orange)

This LED only indicates the status of modem communication.

No modem connected, or LED disabled Off
Modem connected and initialized no communication active Orange on
Modem connected and communication active Green on
Modem connected but errors active (like provider missing, no initialization possible) | Red on
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Table B LED BUS meaning

5.1.1 POL895 External HMI
New POL688 Microtech 4 controllers does not have an integrated HMI. The interaction with the controller can be done
using a mobile app that can be download from the store (Playstore for Android devices and Apple Store for iOS devices).

Figure 1 Blank POL688
Optionally is possible to order the Remote HMI POL895 (P.n 10000110036)
As an option the external Remote HMI can be connected to the UC and offers the same features as the inbuilt display plus
the alarm indication done with a light emitting diode located below the bell button.

All viewing and setpoint adjustments available on the unit controller are available on the remote panel. Navigation is
identical to the unit controller as described in this manual.

“0

5 MicroTecha
@ Lo

Figure 2 POL895 HMI

a) How to connect the POL895 External HMI
The POL895 External HMI can be connected to the available CE+ CE- port on the POL688 controller located in the bottom
connectors row of the controller

Figure 3 POL895 and POL688 ports
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a) Open the back side of the POL895

b) Connect the CE+/CE- ports on the External HMI to the CE+/CE- ports on the POL688

c) Power the POL895 by connecting the 24V on the +24V / GND ports (it is possible to use the POL688 power
supply)

o .. v & :
s g.. ¢ -
YN

e

l||\."l

Figure 4 Back side of POL895

d) Close the back side of the POL895
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a)

SD-Card specifications
e All SD Cards are supported

P DAIKIN

and some SDHC cards

e Fast speed SD Cards are supported (class 2)

e  Supported File system: FAT

16 and FAT32

Cards up to 2Gbyte are fully supported

How to check if SD supported

Not all the software has this option, but most software will allow to check the compatibility of the SD card with the

controller by following this procedure:

1. Insert the service Password
2. Go to the Save/Restore menu

INTERNAL USE ONLY

INFORMATION

Save/Restore Menu Location

Chillers Software: - Main Menu

AHU Modular and Professional AirStream Software: Commissioning ->Config

Save/Load

AHU Professional D-Stream Software: Commissioning - Save/Load

3. Insert the SD card in the dedicated slot.

Figure 5 Controller dedicated SD card slot

e Ifthe SD Card status shows ReadWrite then the SD Card is supported

L |save/Restore b
SD Card ReadWrite | -
Software Update Idle P
Save Parameter Ne B
Status Idle
Restore Parameter Ne B
Status Idle
Save Memory No P
Reset Defualt No b

Figure 6 Compatible SD card message

e Ifthe SD Card status shows NoCard then the SD Card is NOT supported
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! |save/Restore b
sD card NoCard l:
Software Update Idle
Save Parameter No P
Status Idle
Restore Parameter Ne P
Status Idle
Save Memory No P
Reset Defualt No b .

Figure 7 Not compatible SD card message

e Ifthe SD Card Status is not shown, means that the software does not have the option to control the SD
Card compatibility.

INFORMATION
nl Some software doesn’t have the “SD Card” string in Save/Restore menu

4. Pin of 2 mm diameter.

-
o
o
£
]
>

Figure 8 SD cards and 2 mm diameter pin

5.2 Update by SD-Card

INFORMATION
The BSP update can only be performed using the SD Card method.
When updating the BSP, the SD card must also contain the software files, otherwise the controller will erase.

a) SD-Card Save Parameters Procedure

1. Insert the SD card into the controller card slot

Figure 9 Controller dedicated SD card slot

2. Use the “Save Parameter” functionality to download PARAM.UCF file from controller to SD Card
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INFORMATION
Depending on the software version, the string of “Save Parameter” functionality can be different.

Refer to the table in paragraph 8.Save/Restore menu string table to use the correct string.
Possible strings are:

e  Save Parameter

e Save Params

e Saveto File

e Saveto SD

@ ik * |save/Restore 3 ¢ s ! |save/Restore b m
[Software Update Idle p - Save Paramss Mo b
Save Parameter No b :: : Eitr Paramis Ha b Yes
Status Idle Liavc To Files [
Restore Parameter No b AT TIIT ToLLT ey
Status Idle s Estr From Files Ko )
Save Memory No b &b Estr File Rslt= Idle
Reset Defualt No b Slawe 2 Labads Ma b
Save Trace on SD b LS} L s Mo}
W) ESC . L] L {
No |
L 2 ISave and Restore b 1CE (0 * |save / Load b Execute |

|5 card state= NoCard sD card NoCard

ISave te SD= Ne B Save Params 3

Save SD Rslt= Idle Load default b

Rstr From SD= No P Load from 5D 3

Rstr SD Rslt= Idle After loading from SD

Rstr Factory= No P restart required 3

Save Params= No P

Rstr Params= No b

en EsC( ! eo EsC {

Figure 10 The Save/Restore menu could look different depending on software version

INFORMATION
Parameter files are now written to the SD card.
Two PARAM files one in “UCF” and one in “BIN” format are stored on the SD card. Copy and

save these files into a new directory in the PC

b) SD-Card Software Update Procedure

1. Upload all unzipped files of the software to the root of the formatted SD card.

WARNING
/!\ SD Card must contain only software .ucf files
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$e 7 QuesioPC > SOHC(D: v

_| ATLAS_3.09.8_Code_687.ucf
| ATLAS_3.09.8_HMluct

_| ATLAS_3.09.8_OBH_687.uct

_| ATLAS_3.09.8_Scopeucf

_| ATLAS 3.09.8_Web.ucf

_| POL687_BSP_V1036.UCF

Figure 11 Example of software unzipped in the root of the SD card

2. Insert SD-Card in the Controller dedicated SD card slot with controller “On”

Figure 12 Controller dedicated SD card slot

3. Turn off power to the controller.
4. Insert the pin in the dedicated slot and gently push the internal reset button

Figure 13 Controller dedicated pin slot

5. Keep the button pushed with the pin and give power to the controller.
INFORMATION
During this phase BSP led blinks green

6. When the BSP led starts blinking red and green stop pushing the pin.
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Figure 14 BSP Led flashes red and green during software upload

1441

7. When BSP led is fixed orange, immediately remove the power from controller.
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Figure 15 BSP Led becomes orange when software upload is completed

8. Give power to the controller

WARNING

(*) At the first start of the controller after the software update, if there is installed any
communication board (Modbus, Bacnet, etc...), it is very important to wait an automatic
uploading of the communication board too. The communication board software update will

start automatically once the controller has started and main board will be restarted when the
update is completed.

9. We strongly suggest repeating the upload procedure (point 2 till 7) twice to guarantee a complete software

upload

10. Once the software upload is complete and the controller restarted, check in the About Chiller menu that the
actual software version corresponds to the one just installed.
In case the software version does not correspond, check that you have the correct software version for the
controller copied on the SD card and repeat point 2 till 7.

About Chiller 4
Unit Serial Mumber
Enter Data
Software ATLAS
2.09.B
BSP 18.36
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Figure 16 About Chiller menu

c) SD-Card Restore Parameters
It's possible to perform a copy of the old parameter settings using the Restore Parameter function as following

On an empty SD card, copy the files PARAM.UCF and PARAM.BIN

Insert the SD card into the controller card slot.

Insert technician password

Go to Save/Restore menu

If the SD Card appears in the menu, check that the SD Card status shows ReadWrite otherwise check that
the SD is well inserted or replace the SD card. If the SD Card is not shown, then the software does not have
the SD Card compatibility test function. In this case just go to step 12.

6. Use the “Restore parameter” functionality to download the PARAM.UCF file from SD Card to controller

agrwNPE

INFORMATION
E] Depending on software version, the string of “Restore Parameter” functionality can be different.
Refer to table in the appendix to use the correct string. Possible strings are:

e Rstr from file

e Rstrfrom SD

e Restore Parameters

e Load from SD

I |save/Restore b ! |save/Restore b
SD Card ReadWrite SD Card ReadWrite
Software Update Idle p Mo Software Update Idle P
Save Parameter No b > — Save Parameter No P
Status Idle Status Idle
Restore Parameter No Restore Parameter No p
Status Idle} Status Pass|
Save Memory No P Save Memory No P
Reset Defualt No b . Reset Defualt No b .

ol ? |save / Load 3
SD Card NoCard "
Save Params 3
Load default 3
Load from SD 3 |_
After loading from SD
restart required P
eL ESC/( |

Figure 17 Save/Restore menu may be different, it depends on the software version

a) The restore parameter function is successful if the Status changes from Idle to Pass.
b) If the status Fail pops out repeat the step 6.

7. Recycle the controller by removing the power supply or select "Apply changes" to restore actively the
parameters, for the AHU select “restart required” in Save/Load Menu.

8. Since the parameter update is done in 2 stages, it is necessary to repeat the Parameter Restore procedure
(from point 2 till point 7) 3 times to guarantee a complete upload of the parameters
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INFORMATION
ﬂl In case the restore procedure fails, all the parameters are set as default.
So, unit, circuit configuration, alarm limits, sensor calibration, compressor run hours and starts,

frequency parameters are anyway possible to update manually.
In case parameters are lost, refer to service support for correct unit configuration.

CAUTION
To double check the parameters already copied, verify each setting according to the Manual

Configuration procedure

5.3 Update by Scope Light
a) Scope Light Application

a) Open the Climatix Scope Light application on your PC.

Climatix Scope Light

Figure 18 Climatix Scope Light Application

b) If the protocol window appears, just close this window by clicking on the X mark on the top right corner

DAIKIN APPLIED EUROPE S.p.A.

Societa unipersonale soggetta ad attivita di direzione e coordinamento di Daikin Industries Ltd

Sede Legale/Operativa: Sede Operativa: Sede Operativa: %
Via Piani di S. Maria, 72 Via Giuseppe di Vittorio, 8 Via Giuseppe Ferrari, 31/33 To
00072 Ariccia (Roma), Italia 20090 Caleppio di Settala (Milano), Italia 36100 Vicenza, Italia

T +3906937311 Cap.soc. € 10.000.000,00 i.v. R.1.RM/ C.F. 04878860586

F +39069374014 PEC: dae@pec.daikinapplied.eu R.E.A. 467651 - P.I. 01318801006 15


mailto:dae@pec.daikinapplied.eu

INTERNAL USE ONLY

P DAIKIN

I8 Octavittight - Climatix SCOPE (Light o
@Vens - B 219 (LG § Connect - serl
S sero [ e |

SIEMENS

Date Levd  irfomaten

020331 4212398 o Fpphcaton Kate changed
020N WAUQR o Apgicaton Sute changed
ARWMNUNU0E ko Appicaton Rate changed
02031 WA5400 o Apphcation Qe changed
2203314230870 o Connection Ste s reset, i
ANWANWD17637 W Cam-wau-nd-
ARWINUBITE48 ko Connection extablehod
02033 WB76R ko Appication Sute changed
ARG UANT o Appication ate changed
A20NUUNTH o Apphcation State changed
AR M2419718 o Cornection State s reset. |

| woaeintguory B

020331 U400 ko Connection Sate i3 o con
20220}31 MZ‘JO‘N o Connection closed

zozzom u:wz?s o Propect saved

2N UNUBE o Project saved

2020331 143034358 o Connection Sate is establa
020N UNUIT o Connection establshed
ARWBIUNKLUZ o Aopicaton Qe changed
220N US000  Wo  Prectuved
AR021724202262 o Project saved
A204R17BNM o Project saved
2002172513479 o Project saved

Time 0204021727527% o Proyect saved

4 dophcaton  ADAMIOGAC 2220131081800  (AOSEZAAEBAIMDISA. ARORITINNE  Ho Project saved

I HMCriComp  ADAMISAM. 2220131083658  BSAMACIANB41A 2RURITARTO o Prctsaved

D MapngComp  ADAMI6A0. 2020131084332  FOMICA20CE34A143 22UNTEN% o Frotect saved
1]
u]

I

HMWed ADAM3OBA_.  202201310837.06 GEICFFSD-20AC4CES-
BACnet

Clert  BACrt cav - a
M UghtVerson- ADAM306A S, 20210930 080010 4B153C32D478-40755.

Figure 19 main window in scope light

b) Siemens POL 688 Controller to PC connection

INFORMATION
In this paragraph, scope light controller connection with USB to Micro-USB cable is explained.
For Ethernet cable connection refer to Paragraph 7. Scope Light — connection by ethernet cable

a) Go to the Settings Tab:
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18 DefaultLight - Climatix SCOPE (Light)
‘#@Menu- H 29 ™ |LJ i @ Connect - POL68S_EE49A8 ~ uUsB
:?J Settings ’E‘] Startup |

Figure 20 Settings Window

b) From the Target dropdown window select POL 6x8
c) From the Interface dropdown window select USB

INFORMATION
In this menu it can be selected the type of connection is intended to use; in this tutorial the USB
connection is explained.

Figure 21 USB to Micro-USB

d) Click on the Save All Tabs to save the current settings.
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[3], DefaultLight - Climatix SCOPE (Light)

AMenu - | 2 : @ Connect ~ POL683 EE49A8 ~ USB
-, . M Staho | .
i% Settings ([ Statp | \H
Communication
nlemet L POLEE Tt
Interface: | USB :
USB
Device: POL688_EE49A8 v
Auih: | |

o

(c) Select USB )

Figure 22 Communication settings

e) Connect the USB - RJ45 cable from the PC to the Siemens Controller
Micro USB Port

naaeaegnnnnnn B2 g e Gl

rHQQQHFIﬂl'lﬂl'lI'II'II'II'IFIH 'I"IF[IIHI’ITFFP%

il i | | s =

H .

LD
|y
i

Micro USB Cable

Figure 23 USB connection cable

INFORMATION

Once the cable is connected, automatically the Siemens controller drivers are installed on the
PC. This operation usually takes just a couple of seconds. When driver installation is done, the
POL688 device becomes available in the Device dropdown menu.
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f)  Select POL688 from the Device dropdown menu
g) Insert Auth Password : “SBTAdmin!”

] DefaultLight - Climatix SCOPE Light (Light)

INTERNAL USE ONLY

|ﬁMenUv E-‘j L] f

I @ Connect 2PpOL63S_EE49A8

~ USB:

;_'.l Settings A
Communication

//’//
PoLeE [/ v
' N

Cumrent Language

from the Dropdown

Target: | Application v
Interface: | USB 41) Click Connect ) Bl | ~Engneeing Unk Sugport
N\ /
““---.________ o enable ~
ussB
Export Cache
Device: & POL6B3_EE49A8 vi 8
Auth:

g) Select POL68S

Menu

Figure 24 Connection Settings

S| DefaultLight - Climatix SCOPE Light (Light

|EMenuv E'j._. 3 b

[l §ig Disconnect - POL62S EE49A2 USE

INSERT AUTH

PASSWORD

ﬁ Settings
Communication Current Language
Target: POLExE ~ Application ~
iextace =5 JEEE - Engineering Unit Support
enable ~
UsB
Export Cache Files
Export
Device: POLE8E_EE45A8 ~
Auth: sesssnnes |

Please enter your PIN

(Tooedl

Cancel

Figure 25 Pin = Daikin Service Password

h) Click on the Connect Button
i) Put the Daikin Service Password when asked for the PIN
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INFORMATION
ﬂl On board controller: when connecting controller, parameters are read by Scope Light. Before
proceeding with any action on Scope Light, the parameter reading process must be completed.

il Browser [ &\ Aam | @ Protocol | [@d Loader

Figure 26 Scope reading parameters

c) Scope Parameters Save procedure

a) On the project page, click on the Parameter Up — and Download then click on the Target -> PC button

DefaultLight - Climatix SCOPE Light (Light) - u] x
g ght (Lig
AMenu - H B ‘| i  §ig Disconnect - POLESS EE4IAE USB
Project ~ &|| @ Setngs |(4 CogProject 'Z Parameter Load" U x
- 5 Defaultlight Parameter Loading
& Setings Restore Selection T — & Torget -2 PC
=8 Cj?"mﬂﬂ {8 Allinstances with mandatory members
& Project (O Al obiect instances wih al members
2 Foot Note
S Wi Target ) Only instances from type:
B
@ e Start Parameter Download
o Diagrostics
@ Data Points
2 Parameter Up-and Download
#7 Documentation
i Watch Pages
(%) Scheduers
= B Trend
W Onine
€ Archive
Choose the Parameter file
name w
Level Informabon Logger &
Info Project saved Progect
Info Profect saved Project
Info Connection State is establs._. Project
Info Connection establshed Project
info Application State changed Project
Info Froject saved Project
info Connection clased Project
022071 05:2009.267  Info Connection Sate is no con Project w
i, M | () Protocol | (@ Loader

Figure 27 Parameter Up — and Download
b) A new file will appear on the window below and it is possible to choose the name of this file. Confirm the

name by pressing enter on the PC Keyboard and the parameter download procedure starts. The procedure
is completed when the progress bar goes to 100%
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DefaultLight - Climatix SCOPE Light (Light - ] x

q ght (Lig

(@Menu - |H ] # 9 ™ || [ §y Disconnect - pOLGSR EEAIAE USB

| Project v || % seftngs | (& ConfigProiect ' Parameter Load" arx
5‘@ DefaultLight Parameter Loading

. d‘ Configuration
B Project

~Once parameter file name is
cenfirmed with the enter buttom
- the procedure starts

Description File Time Type
Parameter-POLESS... ParameterPOL.. - Image

| Protocal -2 x
|| Date Level Information Logger &
g’ 20220711 09:20:09.139  Info Connection dosed Project
= || 20220711 09:2009.267  nfo Connection Stateis no con...  Project
3
5 || 20220711 092757700 kfo Project saved Project Progress bar
g'(| 202207-11 09:27:57.803 o Project saved Project
2022-07-11 09:27.58,176 nfo Connection State is establis Project
20220711 09:27.58.228  Info Connection established Project
20220711 09:27:58.307 Info Application State changed ...  Project
20220711 09:34:19429  Info Parameter ParameterPOL..  Para... v

A, Marm | @) Protocol Loader

Figure 28 Parameter Up — and Download

d) Scope Software upload procedure
a) Enable the Loader window by going to: Menu ->View->Loader

] DefaultLight - Climatix SCOPE Light (Light) = m] X
(@@ menu ~||[E (] # |9 ™ |LJ i §g Disconnect v pOL68R FE49A8 USB |
|Tl Project 3 - % Settings | 4bx
Recent Projects Communication Cument Language
Application » Target: |POI.®=8 e | ‘W‘:m e |
JEEEEEEEREEE I |
AT Startup Alt+s Engineering Unt Suppar
@ Hep b 8% Settings F2 enable v
@ Eit ann Gked Expott Cache Fles
= Bgnastcs Protocol Alt+P E
- Data Foints E Loader Alt+L _05B4A3 v | |
2 Parameter Up-
. ..|=\'il Decumentation Restore Default Layout AIt*Y\

Watch Pages
Schedulers

Enable Loader
window

| Protocol - B X

ﬂ Date Level Infamation Logger ~
E 202240711 09:20:09.267  Info Connection State is no con Project
= || 202207-1109:27:57,700  Info Project saved Project
5 || 202207-1109.27.57.803  Info Project saved Project
|| 20220711 092756176  Info Connection State is establis... Project
2022407-1109:27.58.228  Info Connection established. Project
202240711 09:27:58307  Info Application State changed Project
20220711 09:34:19429  Info Parameter Parameter-POL,,  Para,..

202207-1109:34:36,059  Info Parameter ‘Parameter-POL. Para... v

A Aarm | @ Protocol | @@ Loader

Figure 29 Enable / Disable Loader Window
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E] DefaultLight - Climatix SCOPE Light (Light)

(@Meu- BB 0™

= |

Project -1

=[] DefautLight ~
& Settings

= @ Configuration
[ Project
& Foot Note

- Mg Target
@ Time
#w Diagnostics

g Data Poirts
& Parameter Up- and Download
¥ Documentation
W, Watch Pages
() Schedulers
€ Calendars

= [ Trend w

DAIKIN

g Disconnect ~ poL68g FF49A8 USB
% Settings |

Communication

Target:  POLG8

Intedace: | USB

UsB

Loader Control
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Software files
window

Loader Control

putton

> X

\ / I/
e | 559 | ko hore | av

[ F N AR RN N AR NSRS NN AN RN N A NNy AN NN R RN NEE A AN NN NN R AN NN NN AN NN AR NN RN NN NN NN NN NN RN NN AN NRRNRR RN

n Type Fie GUID Target GUID Message .
.

U Application  MBRTCode uct E4902454-8249-4605-5CIC-FE22883D5088 o
B HMICof-Comp  Hblcomp uch 632C476F-DF9B-4914-4132 B2DAF2E 16848 :
E MappingComp  OBHVHcomp uck BSSAE158-2679-4F 77-BBF 1-91DCE8E53180 b
HMidWeb  HMI4Webuct CDE91A79-4D0E4CD3 3D 10-55D4239CAEFD o
BACnet Client  BAChet csv . I
Light-Version-..  ScopeCorfig.uc o

o

: o
: o

Load

Cancel
EEEEEEEN

/j\Nann\ﬂPmmcgl.\@Luaderl -

Figure 30 Loader Window

b) Double click on the first raw in the Loader Window
The Browse window will appear
c) Copy the output folder address to be able to create a shortcut of this folder on the desktop. In this folder

we need to copy the Software files later.

[ DefaultLight - Climatix SCOPE Light (Light) - O X

@Mens- @O B9

J U‘ §ig Disconnect - POLGSS EE49A8 USE |

Project ~ 2| % Settings | b x
5] Defautlight ~ ||| Communication Curent Language
&% Settings Taget: | PoLGs ] "3 Browse for Appiication - o X
= ¥ Configuration eface: [USB v [ = ; ]
B Project Interface: ! J
i...q%s Foot Note Files Modiied Size \
W Target uUs8 ATLAS_403A Code 687uci 20220304 07:44.16 w0 k8
) Time
i.#w Diagnostics
=)@ Data Points
<% Parameter Up- and Download
2
|47 Documentation Z)CO the
B, Watch Pages 1) Double click py
Schedul .
i) Schedudem r one of the six output folder
L.l Calendars
— address

" Fles | BSP | Auto Upgrade ar
Type File Time GUID
Application TCe -
[ HMICrf-Comp  HMicomp uck
[ MappingComp  OBHVNcomp uct AS31ANCT-837A-4372-B0B2-E114EFCBBE11
[ HMigwes HMI4Web ucf 18D39D0OE3-BC2B-44F3-9859-57A43071E1FD
[ BACnet Client  BACnet.csv -
[ Light-Version-... ScopeConfig.ucf TB277C61-411E-4543-A531-156C84118E56
Load Cancel
&, Alamn | @) Protocol | @ Loader
Figure 31 Copy the Output folder address
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Open the file explorer on your computer and paste the Output folder address in the address bar

INTERNAL USE ONLY

M 1 = | Output - o X
n Home  Condividi €
- v 1 \ C:\Users\andrei.balan\AppData\Local\SBT\Rainbow: \DefaultLight\Output] PENS! £ Cercain Output
.
@ OneOrive - Daikin Applied Erope Sp.a A Nome - Ultima modifica Tipa Dimensione
» Questo PC [] ATLAS_4.03.A_Code_687.uct 04/03/2022 07:44 File UCF 440 KB
2 Apple iPhone | ATLAS_4.03.A_ HMLuct 022 09:08 File UCF 82KB
[ Deskiop J ATLAS 4.03.A_OBH_687.ucf /0372022 09:00 File UCF 76 KB
4 Documenti [ ATLAS 403.A_scope.uct 23/12/2020 1622 File UCF 30 KB
& Download ] ATLAS_4.03.A_ Web.uct 02/03/2022 09:08 File UCF 365 KB
- | POLEBT_BSP_V1036UCF 5/05/2019 1827 File UCF 3.043 KB
&=/ Immagini
b Musica
2B Oggenti 30
B video
.3 Disco locale (C) Paste the Output folder
@ Rete address on the address bar
of the File Explorer
v

6 elementi

Figure 32 Paste the Output folder address in the address bar of the File Explorer

e) Create a shortcut of the Output folder on your desktop

Crea collegamento in Desiiop

.
"
d

Camnracenre - (IR 210028 FIL " Nome
@ OneDrive - Daikin Applied Europe Spa
ATUAS 4034 Code 667.uct

= Questo PC ATLAS_4.03A HMiuct
W Apple iPhone ATLAS_4.03A OBH_687.uct
W Desktop ATLAS 4034 scopeact

% Documenti ATLAS 403 A Web.uct
& Download ] POLES7_BSP_V1036.UCF
& Immagini
2 Musica
3 Oggetti 30

:-::w.@ Drag And Drop the Output

@ Rete folder to create a shortcut
of this folder on Your
widows desktop

Figure 33 Create Output folder shortcut

f)  Open the shortcut of the output folder from desktop. Make sure to delete all existing files and copy in this
folder only the unzipped files of the software you need to update on the Siemens Controller.
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g) From Scope Light Loader Control window select now the files to be updated on the Siemens Controller:
Double Click on the raw of Loader window and when the browse window appear, select the file

[ DefaultLight - Climatix SCOPE Light (Light) - m} x
#@Meru - |E [) [# | © ||J i @ Disconnect - POLGSS EE49A3 USB
Project v B | §% Settings | b x
=" E Default Light A Communication Current Language
-2 Settings Target: [FoLea ~| "3 srowse tor appiication - o x
=} ﬁ!’ Configuration =
: B Project Interface: |USB v| [=:\Users andres balan \Agp Data\Local\ SBT\Rainbaw Scope \Defaut ight \Outout |
2 Foot Note Files Modfied Size
-l Target use ATLAS_4.03A Code 687ucf 20220304 074416 440KE
LT Time
L% Diagnostics
=-§# Data Points
i 2% Parameter Up- and Download
-+ N
[#.5 Documentation
L5 Watch Pages 1 Double click 2)Select the
Schedul i i i
ers nllone of the six Application file
&l Ca\eﬂdars

- Files BSP | Auto Upgrade

Type File Time GUID get GUID S
Application MEBRTCode ucf = = ABB19093-3DA7-4EBD-BAA3-3ECA2AFBCOCC
[ HMICnf-Comp  HMlcomp uck - - BC7BB6AD-2005-4393-ATBC-EB48521F5FEF
[ MappingComp  OBHVNcomp.ucf - - AIINADCT1-837A-4372-BOB2-E114EFCBBEN
[ HMI4Web HMI4Web ucf - - 18D3D0E3-BC2B-44F3-5B59-57A43071E1FD
] BACnet Client  BACnet csv - - -
[ Ught-Version-... ScopsCorfigucf - - 7B277CE1-411E-4543-A531-156C84118E56
Load Cancl

/s Aam | @ Protocol { Loader I

Figure 34 Select software files

h) Repeat “step g” for all the remaining files: HMI-Cnf-Comp, Mapping-Comp, HMI4Web, Light-Version-
Config except BACnet Client, until all the software files are selected

i)  Before the update can begin, the application on the controller needs to be stopped. To do so the controller

can be updated.
To stop the controller application, go to: Menu - Application-> Stop

E] Defauitlight - Climatix SCOPE (Light)
@Menu- ] || # 9 ™ | LJd g Disconnect ~POL683 EE49A3 USB

I Project » l v q ] 4% Settings
Recent Projects  » Communication Curmrent Language
I Application v O st Jorget:  |FOLGS V|  |Aeplcation it
View » (O Stop intedace: |USB Y| Engneering Unit Support
o Help » I \\%\ ] enable v
_ Stop applica n target system
B Exit Export Cache Files
--@# Data Points Device: POL! 49A8 v
?,- Parameter Up- and Download Fo
{£ ¥ Documentation t
Watch Pages
(P Scheduers top the application on the
@ Calendars Siemens controller
= Trend
BB Oniine
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Figure 35 Stop Controller Application

INFORMATION
The controller enters in software update mode: the display will be OFF and the BSP led Orange

HENE|ENRERRAN|ERERERRR|RRN) AN lII_I__I

(D)
Display OFF O
D

i BSP BUS

h_—| HEIERERERRIRERERRINENINN Iitm

Figure 36 Controller in Software update mode

j) If the Connection to device has been lost! Window appears, press OK and recconect again to the
controller.

Climatix SCOPE

8 Connection to device has been lost!
| |

Show this message again

Figure 37 Connection lost warning

INFORMATION

After the application stops on the controller, this could result unavailable on the Scope Light
Application, and it could be necessary to disconnect and reconnect the USB cable until the
controller becomes again available and is possible to reconnect by clicking on the Connect
button.
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i § Connect - ~ USB Connection to device has been lost!

Unplug and recconect the USB until
the controller is again available

G Connect ~ [JOEEREIZN M ~ USB Connection to device has been lost!

Figure 38 Controller not available

k) Once reconnected, a warning window will reappear to let you know that the application has been stopped
on the target (controller). Acknowledge this warning by pressing OK.

Project *

e Application on target stopped or not loaded.

oK

Figure 39 Application stopped warning

) It's possible now to start software update by clicking on the “Load” button on the loader control window.

Type File Time GUID Message
EA Application ATLAS_4 03 A_Code_687ucf 2022-03-04 07:44:16 FAD04DCD-23A2-42AE-
EA HMICrf-Come ATLAS_4.03.A_HMluck 2022-03-02 09:08:14 SASC105D-6481-45C3-9.. Start Software update
B4 MappingComp ATLAS_4.03.A_OBH_687.ucf 2022-03-02 09:00:54 2DDFB21D-D707-47D8-
A-447E4TFED-

ATLAS_4.03.A_Web ucf 2022-03-02 09:08:26

Figure 40 Start Software Update

m) The software update is completed when on the Message column all the voices show “completed”

Fles | BSP |
Type File Time GUID Target GUID
Application ATLAS_4.03A_Code_687.ucf 20220304 07:44:16 FAD0ADCD-23A2424E-.. - Completed
[ HMICrf-Comp ATLAS_4 03 A_HMIucf 20220302 05.08:14 SASC105D-64B1-45C39.. - Software update Completed
4] Mapping-Comp ATLAS_4.03A_OBH_687 ucf 2022-03-02 09:00:54 20DFB21D-D707-47DB-.. - Completed
HMi4Web ATLAS_4.03A_Webuct 20220302 03:08:26 DOICFAIAL4TC4ED-.. - Completed Completed
] BACnet Client BACnet csv - - -
[ Light-Version-Config ATLAS_4.03.A_scope.ucf 2020-12:23 16:22:28 DE56FAC2411A4CSEA... - Completed
Load Cancel
Figure 41 Software update completed
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n) Restart the application on the controller by selecting Menu - Application - Start

E] DefaultLight - Climatix SCOPE (Light)

4’ Menu+| ) 2 kd ' §p Disconnect ~ POL688_EE49A8 USB
: Project »
Recent Projects  » Cument Language
| Application »[[O sat ) v/ |Aepicaton v
View > “CF\\\ Y| Engneering Unit Support
e Help > [ Start applxca\e\\cn target system ] v
B Exit

Device: POL688_EE49A8

Auth:

Start Target Application

Figure 42 Start Target Application
0) Once the software upload has completed and the controller restarted, check in the About Chiller menu
that the actual software version corresponds to the one just installed. In case the software version does
not correspond, check that you have the correct software version for the controller copied on the output
folder repeat the software update procedure.
About Chiller b
Unit Serial Number
Enter Data

Software

B5P 169. 36
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Figure 43 About Chiller menu

p) Once the software is successfully updated, it is possible to restore the parameters on the controller.
e) Scope Parameter Restore procedure
a) From the Project page click on the Parameter Up- and Download
b) Step 1) Select the option All object interface with all members
c) Step 2) Select the desired parameter file
d) Step 3) Click on the PC->Target button and confirm the parameter upload
e) Parameter upload procedure finishes when the progress bar arrives at 100% and disappears
[-1 Defaultlight - Climatix SCOPE (Light) - o x
@Avenu - | [ B kel & | §g Disconnect ~ POL68 EE49A8 USB
Project ~ B % Setings ' 2 Parameter Load® x|
[ Defauigt Moo
& Settings Restore Selection § PCo> Taget $ TamaoPC
=3 4 Cn;fwmm O Alinstances with mandatory members Step 3) Start Parameter upload into
- e © Mctject instances wih o menbens the controller
i Tore O Only instances from type:
o s Step 1) Select All object interface
& Data Ponts with all members
& Parameter Up- and Download
# % Documentation
. Watch Pages
) Scheduers Description File Time Type
€] Calendars Parameter ramcter—POL.. 20220403 Image.
= [l Trend parameter 2 Parameter S0 Image
M Oriine parameter 3 ParameterFOL... 2022050 Progress bar
€] Archive Step 2) Select the desired parameter
files
L .i
Figure 44 Parameters upload procedure
f)  Recycle the controller by removing the power supply or select "Apply changes" in menu Commission Unit
- Configuration = Unit &> Apply Changes = YES to restore actively the parameters.
g) Since the parameter update is done in 2 stages, it is necessary to repeat the Parameter Restore
procedure twice
h) The Software update and Parameters restore procedure are completed.

INFORMATION

In case the restore procedure fails, all the parameters are set as default.

So, unit, circuit configuration, alarm limits, sensor calibration, compressor run hours and starts,
frequency parameters are anyway possible to update manually.

In case parameters are lost, refer to service support for correct unit configuration, attaching the
unit serial number.
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6 POL 687 (Phased Out — Microtech 3)

6.1 Description

(A) (B)
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Figure 46 a) SD Card slot b) T-IP port c) Pin Hole d) LED (b)
LEDs for diagnostics
.
BSP BUS

Figure 47 BSP BUS LEDs

e LED BSP "Run/ Stop": 3 colours (green, red, and orange)

SW update mode (download application or firmware) | Every second alternating between red and green
Application running Green on

Application loaded, but not running Orange on

Application not loaded Orange flashes: 50 ms on, 1000 ms off
Firmware error Red blinking at 2 Hz

Hardware fault Red on

Table C LED BSP meaning
e LED BUS: 3 colours (green, red and orange)
This LED only indicates the status of modem communication.

No modem connected, or LED disabled Off
Modem connected and initialized no communication active Orange on
Modem connected and communication active Green on
Modem connected but errors active (like provider missing, no initialization possible) | Red on

Table D LED BUS meaning
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6.1.1  SD-Card specifications

All SD Cards are supported and some SDHC cards
Fast speed SD Cards are supported (class 2)
Supported File system: FAT16 and FAT32

Cards up to 2GByte are fully supported

a) How to check if SD supported

Not all the software has this option, but most software will allow to check the compatibility of the SD card with the controller
by following this procedure:

1. Insert the service Password
2. Go to the Save/Restore menu

INFORMATION
Save/Restore Menu Location
e Chillers Software: > Main Menu
e AHU Modular and Professional AirStream Software: Commissioning ->Config
Save/Load

e AHU Professional D-Stream Software: Commissioning - Save/Load

3. Insert the SD card in the dedicated slot.

Figure 48 Controller dedicated SD card slot

e Ifthe SD Card status shows ReadWrite then the SD Card is supported

! |save/Restore 3
sD Card ReadWrite | -
Software Update Idle
Save Parameter No
Status Idle
Restore Parameter No b
Status Idle
Save Memory No
Reset Defualt No -

Figure 49 Compatible SD card message

e Ifthe SD Card status shows NoCard then the SD Card is NOT supported
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! |save/Restore b
sD Card NoCard I
Software Update Idle
Save Parameter No B
Status Idle
Restore Parameter Moy b
Status Idle
Save Memory No P
Reset Defualt Mo b .

Figure 50 Not compatible SD card message

e Ifthe SD Card Status is not shown, means that the software does not have the option to control the SD Card
compatibility.

INFORMATION
Some software doesn’t have the “SD Card” string in Save/Restore menu

4. Pin of 2 mm diameter.

VEINSOL

Figure 51 SD cards and 2 mm diameter pin

6.2 Update by SD-Card

INFORMATION
The BSP update can only be performed using the SD Card method.
When updating the BSP, the SD card must also contain the software files, otherwise the controller will erase.

a) SD-Card Save Parameters Procedure

1. Insert the SD card into the controller card slot

Figure 52 Controller dedicated SD card slot

2. Use "Save Parameter 2 Yes” function to download PARAM.UCF file from controller to SD card
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INFORMATION
Depending on software version, the string of “Save Parameter” functionality can be different.
Refer to the table in appendix to use the correct string. Possible strings are:
e  Save Parameter
e Save Params
e Saveto File
e Saveto SD

0 b ! [save/Restore N m § ! |save/Resters ] m
Save Paramgs N b Save Params= L
kitr Params ho b YE’S Bitr Paramss No b I-: YES
Ls,.m To Filos rr— l':’ LS.n--: To Filgs Wa b
ETITTIIT ™y TTVE TIIT TUITY e
Estr From Files [ Bstr From Files Na
Estr File Rslts Idle Estr Flle Rslts Tdle
Slave 2 Loads [T Glave @ Loads Ma b
Slave 3 Loads " Slave 3 Loads Na b
e 5| [ 40 [=Tel [
o |
€ Infe * |save and Restore 2 Yes @§ Wi ! |save / Load 3 B
SD Card States= NoCard SD Card NoCard
Save to SD= No P Save Params 3 )—I
Save SD Rslt= Idle Load default 3
Rstr From SD= No Load from SD (3
Rstr SD Rslt=s Idle After loading froem sSD
Rstr Factory= Ne P restart required 3
Save Params= Ne P
Rstr Params= No b
en Esc f . @O Esc( {

Figure 53 The Save/Restore menu could look different depending on software version

INFORMATION
Parameter files are now written to the SD card.
Two PARAM files one in “UCF” and one in “BIN” format are stored on the SD card. Copy and

save these files into a new directory in the PC

b) SD-Card Software Update Procedure

1. Upload all unzipped files of the software to the root of the formatted SD card.

WARNING
/!\ SD Card must contain only software .ucf files
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$ > QuesPC > SOHC DY vl

[ ATLAS 3098 Code_687.ucf
] ATLAS_3.09.8_HMLucf

[ ATLAS 3,098 OBH_687.uct
U] ATLAS 3098 Scopeuct

(] ATLAS 3098 Web.ucf

7] POLE87_BSP_V1036.UCF 13

Figure 54 Example of software unzipped in the root of the SD card

2. Insert SD-Card in the Controller dedicated SD card slot with controller “On”

Figure 55 Controller dedicated SD card slot

3. Turn off power to the controller.
4. Insert the pin in the dedicated slot and gently push the internal reset button

Figure 56 Controller dedicated pin slot

5. Keep the button pushed with the pin and give power to the controller.
INFORMATION
During this phase BSP led blinks green

6. When the BSP led starts blinking red and green stop pushing the pin.
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Figure 57 BSP Led flashes red and green during software upload

1441

7. When BSP led is fixed orange, immediately remove the power from controller.

MO PO O EO

Lo
=@
o

A e &

Figure 58 BSP Led becomes orange when software upload is completed

8. Give power to the controller

WARNING

(*) At the first start of the controller after the software update, if there is installed any
communication board (Modbus, Bacnet, etc...), it is very important to wait an automatic
uploading of the communication board too. The communication board software update will

start automatically once the controller has started and main board will be restarted when the
update is completed.

9. We strongly suggest repeating the upload procedure (point 2 till 7) twice to guarantee a complete software

upload
10. Once the software upload is complete and the controller restarted, check in the About Chiller menu that the

actual software version corresponds to the one just installed.
In case the software version does not correspond, check that you have the correct software version for the

controller copied on the SD card and repeat point 2 till 7.
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About Chiller 4
Unit Serial MNumber
Enter Data
Software ATLAS
3.09.B
BSP 18.36

Figure 59 About Chiller menu

c) SD-Card Restore Parameters
It's possible to perform a copy of the old parameter settings using the Restore Parameter function as following

On an empty SD card, copy the files PARAM.UCF and PARAM.BIN

Insert the SD card into the controller card slot.

Insert technician password

Goto Save/Restore menu

If the SD Card appears in the menu, check that the SD Card status shows ReadWrite otherwise check that
the SD is well inserted or replace the SD card. If the SD Card is not shown, then the software does not have
the SD Card compatibility test function. In this case just go to step 12.

6 Use the “Restore Parameter” functionality to download the PARAM.UCF file from SD Card to controller

agrwhPE

INFORMATION
Depending on software version, the string of “Restore Parameter” functionality can be different.
Refer to table in the appendix to use the correct string. Possible strings are:
e Rstr from file
e Rstrfrom SD
e Restore Parameters
e Load from SD

I |save/Restore S I |save/Restore 3
SD Card ReadWrite SD Card ReadWrite
Software Update Idle b %o Software Update Idle b
Save Parameter No b > :01:” Save Parameter No b
Status Idle Status Idle
Restore Parameter No Restore Parameter No p
Status Idle} Status Pass|
Save Memory No P Save Memory No Db
Reset Defualt No b . Reset Defualt No b .
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Ll ° |save / Load 3
sD Card NoCard >
Save Params 3
Load default 3
[Load from sD b |
After loading from SD
restart required 3
AN ESC

Figure 60 Save/Restore menu may be different, it depends on the software version

a) The restore parameter function is successful if the Status changes from Idle to Pass.
b) If the status Fail pops out repeat the step 6.

7. Recycle the controller by removing the power supply or select "Apply changes" to restore actively the
parameters, for the AHU select “restart required” in Save/Load Menu

8. Since the parameter update is done in 2 stages, it is necessary to repeat the Parameter Restore procedure
(from point 2 till point 7) 3 times to guarantee a complete upload of the parameters

INFORMATION
E] In case the restore procedure fails, all the parameters are set as default.
So, unit, circuit configuration, alarm limits, sensor calibration, compressor run hours and starts,
frequency parameters are anyway possible to update manually.
In case parameters are lost, refer to service support for correct unit configuration.

CAUTION
To double check the parameters already copied, verify each setting according to the Manual
Configuration procedure

6.3 Update using Scope Light Application
a) Scope Light Application

a) Open the Climatix Scope Light application on your PC.

Climatix Scope Light

Figure 61 Climatix Scope Light Application

b) If the protocol window appears, just close this window by clicking on the X mark on the top right corner
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L § Connect ~ Serial
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A20331 A B98 o Hophcaton Sate changed
0203 WAUQR o Aogicaton Sute changed
2020331 24408 o Appication Sate changed
2020331 215400 o Aophcaton Sate changed
020330 W230870 e Connection Sute s reset,

[“nnnnlm [ 3y

12 Warnyg Do reset
QI UA17637 o  Connecton Sate s establs
ARWNUB17648 o Connection establshed
220N MBI o Aopbcaton Sute changed
22BN UDBNT o Appicaton Sate chinged
2N UANTH o Kopbcaton e chaged
A2WNUA9718 o Connection State i reset.|.

20331 14244070 ko Comecton Sutesnocon
20331 1424040704 o Comecton chosed
A2033 WNU2E o Project saved
2B UNUBE Ho  Proectseved
220331 1400 o Comection tuteis etabln
22031 UNUIND ko Comecton estabished
20BN UNUMU2 ko Apicaton Rute changed
203 WS008 Wo  Project uved
NRURTURNX o  Projectsaved
2040217250154 bo  Proectsaved
201NN o Prjectsaved

Tie NROL2 152 ko Proectsaved

P Acicaton  ADAMIGAC. 2220131081800  OMSEZAAEBADMDMSA. | NROU2TTINNKI o Froect saved

I HMICHComp  ADAMIGAM. 2020131083658  BSACIAWB4INA 2RQITAIRTO o Proct saved
MwprgComp ADAMI06A0. 2020131084332  FOMXA2DCE34AI4S. 2076 o Project saved
D HMWe>  ADAMIOGA. 2020131083706  GEICFFSD20ACACES..

[JBAChtClert  BMratew - .

[ UghtVerson- ADAMIDGA S 0210330080010  4BISACE2D4TBL0TSS

I

Figure 62 Main window in Scope Light

b) Siemens POL 687 Controller to PC connection

INFORMATION
In this paragraph, scope light controller connection with USB to RJ45 service cable is explained.
For Ethernet cable connection refer to Paragraph 7. Scope Light — connection by ethernet cable

a) Go to the Settings Tab:
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B] DefauitLight - Climatix SCOPE (Light)
@@Menu- | ) 89 & |LJ @l § Connect - POL6S7 093388  ~ USB |

Figure 63 Settings Window

b) From the Target dropdown window select POL 687
c) From the Interface dropdown window select USB

INFORMATION
In this menu it can be selected the type of connection is intended to use; in this tutorial the USB

connection is explained.
The USB to RJ45 service cable is available as a Daikin Spare Part: PN 10000109500

Figure 64 USB to RJ45 service cable P.N. 10000109500

d) Click on the Save All Tabs to save the current settings.
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E5] DefaultLight - Climatix SCOPE (Light)
pannn
@Menu~- B [ 2 ik ° § Connect - POL687.09338B - USB

4".' Settings [;j Startup
Communication

e

%, Jarget: POL687 v

BN NN R IR EEEE R EEEEEEEEEREEERRERRERNRRREREE

* Interface: | USB v

----------------------------------------------

d) Saves all tabs

Device: POL687_093388 ~

Auth: b) Select POL 687

c) Select USB

Figure 65 Communication Settings

e) Connect the USB - RJ45 cable from the PC to the Siemens Controller

L P

-
=)
| —

saBanilanananslannanslanalansiLaiind

N

Port T.

USB to RJ45 Cable

&L Y

Figure 66 USB Connection Cable

INFORMATION
Once the cable is connected, automatically the Siemens controller drivers are installed on the
PC. This operation usually takes just a couple of seconds. When driver installation is done, the

POL687 device becomes available in the Device dropdown menu.

f)  Select POL687 from the Device dropdown menu
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[-j DefaultLight - Climatix SCOPE (Light)
@Menu - [ ) # || B §§ Connect +iPOL687 093388 |+ USB :

a Setti -
Communication Cument Language
Target: _POLSS? Application v|
Interface: _USB Engineering Unt S
enable v
USB
Export Cache Files
Auth: ]
g) Select POL687
from the Dropdown
Menu
Figure 67 Connection Settings
B8 Defauittight - Climati
@Menu- | 20 ™ | W Disconnect » POL687 093388 USB
> Settings [ Satp
Commurscation Cument Language
Target: POLES7 ¥ | Apphcation w
interface: | USB ~ E Unt §
enable bl
use
Bxpont Cache Fles
Device: POLES7_093338 v
o [ Please enter your PIN

P

Lok ] | Conce

Figure 68 Daikin Service Password

g) Click on the Connect Button
h) Put the Daikin Service Password when asked for the PIN
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INFORMATION
. On board controller: when connecting controller, parameters are read by Scope Light. Before
proceeding with any action on Scope Light, the parameter reading process must be completed.

|Read|ng nbjed O 2201 U\Estnp&wﬁd

Figure 69 Scope reading parameters

c) Scope Parameters Save procedure

a) On the project page, click on the Parameter Up — and Download then click on the Target -> PC button

] Oetauitight - Climatix SCOPE (Light
Aves- | 0 2 |l g Disconnect = POLSET 093348 U368
| || e 2 Porameter Load
ST Farameter Loadng

: Start Parameter Download
.‘w
ﬁ.DuaPom

v
i Dooumentatizn

; Wikch Pages
Cohadden Descrpbon ) Fe Time Tipe

! Clerdan -‘1“ Parmster-POL
BT
Bow —
Choose the Parameter file
name

Figure 70 Parameter Up — and Download

b) A new file will appear on the window below and it is possible to choose the name of this file. Confirm the
name by pressing enter on the PC Keyboard and the parameter download procedure starts. The procedure

is completed when the progress bar goes to 100%
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ﬂ“'"“' BLORi20e QE iy Disconnect + POLEET 033338 USB
™ SRl ® snn 2 Parneter Lond'
Paramater Loading

INTERNAL USE ONLY

Once parameter file name is
confirmed with the enter buttom
the procedure starts

Progress bar

Figure 71 Parameter Up — and Download

d) Scope Software upload procedure

a) Enable the Loader window by going to: Menu ->View->Loader

[ Defauitlight - Climatix SCOPE (Light)

Aenu+| [ [ B |~ J i | g Disconnect = POLGAT 053388 USB

B Pojea ' T8 setinsn
Recent Projects Communication Cumert Language
Appication ) Taget  POLEST ¥ | hephcation v
e EEET
| View ] statup AltsS Ergreemny Lnt Supcot
SRR AT Settings ] enable v
@ bt Alarm Alted Ewor Cache Fles
T e el e dwtearh nmn e =
S Omaforts % IG] Loader [ ] v
2 Porameter Uiy, )
& ™ R AR L 1R

T

Enable o &

Enable Loader
window

|| Acore Mam | Mamlogong | Acive Events | Ever Logong

S Ten Obes Vo Tet
§llv me sam. Py
1 22 w20 1 EstopS.
Y Evasl
1 ox a7 OATem
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Figure 72 Enable / Disable Loader Window
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[E Detaulttight - Climatix SCOPE (Light)

- a X
WBMenu - [ ) # |9 ™ L) §p Disconnect + POLEST 03268 USB
Project » B % Settings P x
& [ Defautign Commurication Curent Language
-‘és-m- Torget: | POLEST ~| [ Appicaton v
5§ Conbiguration
B Proect imiecn: Y| Engnesng Unt Suppont
= Foot Note P v
-l Toget usB
) Tme Expont Cache Fles
“ Disgnostics Beot
5@ Deta Ports Device:  POL687_033388 ~
& Parameter Up- and Download ————
1£1, Documertation Auh
%w-mmﬂ
() Scheduens
€ Calendars
& [l Trend
I Onine

Software files
window

Loader Control
button

ADAM306AC. 2022131081800
ADAM306AH.. 202201-31083658
ADAM306A 0. 2022013108432
ADAM 306A_ 20220131 08:37:06
BACnet csv . -
- ADAM30BAS. 2021-03-3008:00:10 4B156C82-D47B4075-5.

Figure 73 Loader Window

b) Double click on the first raw in the Loader Window
The Browse window will appear

c) Copy the output folder address to be able to create a shortcut of this folder on the desktop. In this folder
we need to copy the Software files later.

[ Detouittight - Climatix SCOPE (Light)

- =] >
@@Menu - B ) 9 © L (o Disconnect + pOLES7 093388 USE
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W Foot Note ensble.
6 Taom use
9""' Evaiceda iy ACZC_6.00.A_Code uct 20211117 07:46:20 253K8
@ Data Ports Device: POLE87_093388 ~ Co
2 Parameter Us- and Danrioad
3 Documentaton L |
*w.m?m
(D) Sehaduien.
€ Caiendan:
& Il Trend
1 Oniee
& ective

le click on
of the 6

Copy the Output
folder address

Taget GUID Message
2022.01:31 0&:18:00
2022-01-31 08.36.58.

=] reorcaton
[ HMI-Crf Comp  ADAM 3.06.

\_HMluch
Comp  ADAM 3.06 A_OBHES7 uck 20220131 08:43.32
A HMiaweb. ADAM 3.06.A_Webusch 202240131 08:37.06
] BACnet Chert  BACnet cov . B
A Ught-Version-. ADAM 3,06 A_Scope.uct 20210530 08:00:10 4B156CE2D4TE4075-9.

Figure 74 Copy the Output folder address

d) Open the file explorer on your computer and paste the Output folder address in the address bar
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W Apple iPhone ‘ ATLAS_4.03.A_HMlucf File UCF 82 KB
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6 elementi

Figure 75 Paste the Output folder address in the address bar of the File Explorer

e) Create a shortcut of the Output folder on your desktop

Crea collegamento in Desiiop

(LT
« Utenti > andreibalan > AppData > Local > SBT » RainbowScope >\Defditlight ; npat .:
[o—— AR 210026 1l Nome difica
@ OneDrive - Daikin Applied Europe Spa
ATLAS 4034 Code 687.uct
ATLAS 403 A HMILuct
¥ Apple Phone ATLAS_4.03.A_ OBH_687.xf
W Deskiop ATLAS 4034 scopeact
% Documenti | ATLAS 403A Web.ucf
$ Download POLEE_BSP_VI036.UCF

= Questo PC

& Immagini
2 Musica
3 Oggetti 30

?::wm Drag And Drop the Output

@ fete folder to create a shortcut
of this folder on Your
widows desktop

Figure 76 Create Output folder shortcut

f)  Open the shortcut of the output folder from desktop. Make sure to delete all existing files and copy in this
folder only the unzipped files of the software you need to update on the Siemens Controller.

g) From Scope Light Loader Control window select now the files to be updated on the Siemens Controller:
Double Click on the raw of Loader window and when the browse window appear, select the file
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Figure 77 Select Software file

h) Repeat “step g” for all the remaining files: HMI-Cnf-Comp, Mapping-Comp, HMI4Web, Light-Version-
Config except BACnet Client, until all the software files are selected

i)  Before the update can begin, the application on the controller needs to be stopped. To do so the controller
can be updated.
To stop the controller application, go to: Menu - Application-> Stop

K] DefaultLight - Climatix SCOPE (Light)

d Menu ~| BLOLgl9oo | Id @ Disconnect ~ POL687_093388 USB
[ Project » v R 4% Settings
i Recent Projects  » Communication Cument Language
| Application o stn Torget:  |POL6S7 | | Application v
View > O Stop Inteface:  USB M| g Unt S
@ Hep » | o l enable v
Stop applica n target system
@ i Export Cache Fies
-)- @ Data Points

& Parameter Up- and Download

Watch Pages
() Schedulers top the application on the
.| Calendars Siemens controller
5|l Trend
I Oniine
€1 Archive

Figure 78 Stop controller Application

INFORMATION
The controller enters in software update mode: the display will be OFF and the BSP led Orange
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Figure 79 Controller in Software update mode

j) If the Connection to device has been lost! Window appears, press OK and recconect again to the
controller.

Climatix SCOPE

0 Connection to device has been lostl
| |

Show this message again

Figure 80 Connection lost warning

INFORMATION

After the application stops on the controller, this could result unavailable on the Scope Light
Application, and it could be necessary to disconnect and reconnect the USB cable until the
controller becomes again available and is possible to reconnect by clicking on the Connect
button.

@ Connect - ~ USB Connection to device has been lost!

Unplug and recconect the USB until
the controller is again available

@ Connect ~ [JoJNEylveEEEl: ~ USB Connection to device has been lost!
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Figure 81 Controller not available

k) Once reconnected, a warning window will reappear to let you know that the application has been stopped
on the target (controller). Acknowledge this warning by pressing OK.

Project Pt

e Application on target stopped or not loaded.

Figure 82 Application stopped warning

I) It's possible now to start software update by clicking on the “Load” button on the loader control window.

Tyve File Time GUID Target Message
EA Application ATLAS_4.03.A_Code_687.ucf 2022-03-04 07:44:16 FADD4DCD-23A242AE-...

EA HMICrf-Comp ATLAS_4.03.A_HMIucf 2022-03-02 09:08:14 SASC1050-64B1-45C3-9...( - Start Software u pdate

EA Mapping-Comp ATLAS_4.03.A_0BH_687.ucf 2022-03-02 09:00:54 2DDFB21D-D70747D8-... -

HMISWeb ATLAS_4.03.A_Web.uch 2022-03-02 05:08:26 DOICF41A447E<45ED ..

] BACnet Client BACnet cov -

Figure 83 Start Software Update

m) The software update is completed when on the Message column all the voices show “completed”

Fles | BSP |
Type File Time GUID Target GUID
Appiication ATLAS_4.03 A_Code_687uc 20220304 07-44:16 F4D04DCD-23A2-42AE-.. - Completed
[ HMICrf -Comp ATLAS_4.03A_HMI.ucf 20220302 09:08:14 9ASC105D-64B145C39.. - Completed
[4 MappingComp ATLAS_4.03A_OBH_687udf 20220302 09:00:54 2DDFB21D-D707-47DB-... - Software update Completed
[ HMIWeb ATLAS_403A_Webuct 2220302090826 DOICFAIAL4TC4IED-.. - Completed Completed
] BACnet Client BACnet csv . . -
[ Light-Version-Config ATLAS_4.03 A_scope uc 2020-12-23 16:22:28 D656FAC2-411A4CS8-A.. - Completed
load | Cancel
Figure 84 Software update completed
n) Restart the application on the controller by selecting Menu - Application > Start
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E] DefaultLight - Climatix SCOPE (Light)

@AMenu - B [ 9 ™ L# ' §p Disconnect - POL687 093388 USB
| Project b
Recent Projects  » Cument Language
l Application > ‘ O Start - ¥ Apphcation >
View » Stop \ ¥ Engineering Unit Support

e, Help [ Start appllca}\q\ﬁ\cn target system i ~

6] Exit

L

Device: POLE87_093388
Auth:

Start Target Application

Figure 85 Start Target Application
0) Once the software upload has completed and the controller restarted, check in the About Chiller menu
that the actual software version corresponds to the one just installed. In case the software version does

not correspond, check that you have the correct software version for the controller copied on the output
folder repeat the software update procedure.

About Chiller b
Unit Serial Number
Enter Data

Software

B5P 168.36

Figure 86 About Chiller menu

p) Once the software is successfully updated, it is possible to restore the parameters on the controller.

e) Scope Parameter Restore procedure
a) From the Project page click on the Parameter Up- and Download
b) Step 1) Select the option All object interface with all members
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c) Step 2) Select the desired parameter file
d) Step 3) Click on the PC->Target button and confirm the parameter upload
e) Parameter upload procedure finishes when the progress bar arrives at 100% and disappears
] Defauitlight - Climatix SCOPE (Light) - a B
A menu - | H 4 kel I g Disconnect = POLGST 093388 USE
Project * B 0% Setngs  Parameter Load® 1px
ST Parameter Loading
£ Setings Flestore Selection o o .
4 r,c:mum ) Mlinstances wih mandatory members P fepe Step 3) Start Parameter upload into ¥ e
- e B e the controller
-l Tapet O COnly instances from type
- ;Tm“ Step 1) Select All object interface
= @ Data Ports with all members
2 Parameter Up- and Downkoad
%% Documen:
;‘ Watch Pages
O scheduen Descrption Fie Time Type
€l c P 0 B -
o e e N -
I Orine parameter 3 FW__——/ . B Progress bar
& dechive ‘-@ 2) Select the desired para@
files B

Figure 87 Parameters upload procedure

f)  Recycle the controller by removing the power supply or select "Apply changes" in menu Commission Unit
- Configuration = Unit &> Apply Changes = YES to restore actively the parameters.

g) Since the parameter update is done in 2 stages, it is necessary to repeat the Parameter Restore
procedure twice

h) The Software update and Parameters restore procedure are completed.

INFORMATION

In case the restore procedure fails, all the parameters are set as default.

So, unit, circuit configuration, alarm limits, sensor calibration, compressor run hours and starts,
frequency parameters are anyway possible to update manually.

In case parameters are lost, refer to service support for correct unit configuration.
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7 POL 638 (Phased Out — Microtech 3)

7.1 Description

Figure 5 (A) POL638 /STD with HMI (B) POL638 /STD without HMI

Figure 89 a) SD Card slot b) T-IP port c) Pin Hole d) LED

LEDs for diagnostics

BSP BUS

Figure 6 BSP BUS LEDs

e LED BSP "Run/ Stop": 3 colours (green, red, and orange)

SW update mode (download application or firmware) | Every second alternating between red and green
Application running Green on

Application loaded, but not running Orange on

Application not loaded Orange flashes: 50 ms on, 1000 ms off
Firmware error Red blinking at 2 Hz

Hardware fault Red on

Table E LED BSP meaning
e LED BUS: 3 colours (green, red and orange)

This LED only indicates the status of modem communication.

No modem connected, or LED disabled Off
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Modem connected and initialized no communication active Orange on

Modem connected and communication active Green on

Modem connected but errors active (like provider missing, no initialization possible) | Red on
Table F LED BUS meaning

7.1.1  SD-Card specifications
e All SD Cards are supported and some SDHC cards
e Fast speed SD Cards are supported (class 2)
e  Supported File system: FAT16 and FAT32
e Cards up to 2GByte are fully supported

a) How to check if SD supported

Not all the software has this option, but most software will allow to check the compatibility of the SD card with the controller
by following this procedure:

1. Insert the service Password
2. Go to the Save/Restore menu

INFORMATION
Save/Restore Menu Location
e Chillers Software: > Main Menu
e AHU Modular and Professional AirStream Software: Commissioning ->Config
Save/Load
e AHU Professional D-Stream Software: Commissioning - Save/Load

3. Insertthe SD card in the dedicated slot.

SIEMENS

Figure 91 Controller dedicated SD card slot

e If the SD Card status shows ReadWrite then the SD Card is supported
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! |save/Restore
5D Card ReadWrite
Software Update Idle
Save Parameter No
Status Idle
Restore Parameter Nao
Status Idle
Save Memory No
Reset Defualt No

e Ifthe SD Card status shows NoCard then the SD Card is NOT supported

Figure 92 Compatible SD card message

Save/Restore

5D Card NeCard
Software Update Idle
S5ave Parameter No
Status Idle
Restore Parameter Mo
Status Idle
Save Memory Mo
Reset Defualt Mo

Figure 93 Not compatible SD card message

INTERNAL USE ONLY

e If the SD Card Status is not shown, means that the software does not have the option to control the SD Card

compatibility.

INFORMATION
Some software doesn’t have the “SD Card” string in Save/Restore menu

4. Pin of 2mm diameter

-
-1
]
=
]
>

7.2 Update by SD-Card

Figure 94 SD cards and 2 mm diameter pin

INFORMATION
The BSP update can only be performed using the SD Card method.
When updating the BSP, the SD card must also contain the software files, otherwise the controller will erase.

a) SD-Card Save Parameters Procedure

1. Insert the SD card into the controller card slot

DAIKIN APPLIED EUROPE S.p.A.

Societa unipersonale soggetta ad attivita di direzione e coordinamento di Daikin Industries Ltd

Sede Legale/Operativa:
Via Piani di S. Maria, 72
00072 Ariccia (Roma), Italia
T +3906937311

F +39069374014

Sede Operativa:
Via Giuseppe di Vittorio, 8

20090 Caleppio di Settala (Milano), Italia

Cap.soc. € 10.000.000,00 i.v.
PEC: dae@pec.daikinapplied.eu

Sede Operativa:

Via Giuseppe Ferrari, 31/33

36100 Vicenza, Italia
R.1.RM/ C.F. 04878860586
R.E.A. 467651 - P.I. 01318801006 52


mailto:dae@pec.daikinapplied.eu

INTERNAL USE ONLY

SIEMENS
SIEMENS

Figure 95 Controller dedicated SD card slot

2. Use the “Save Parameter” functionality to download PARAM.UCF file from controller to SD Card

INFORMATION
Depending on software version, the string of “Save Parameter” functionality can be different.
Refer to the table in appendix to use the correct string. Possible strings are:
e  Save Parameter
Save Params
Save to File
Save to SD

i b ! |save/Restors

Save Parasse

(]
Estr Paramis Mo Yes
Lsaue To Files [T} H I

Estr From Files Ko
Save Memory No b  PARAMAICE Rstr File Rslts Idle
Reset Defualt No b AR Elawe 2 Losds Na b
Save Trace on SD ok Zlawe 3 Loads L.
e ESC ‘ = “0 ol ‘ o
tio |
€ Info 2 |save and Restore 3 Yes L L ! |save / Load 3 m
SD Card State= NoCard - SD Card NoCard
ave to SD= No P Save Params 3
Save SD Relt= Idle Load default 3
Rstr From SD= No b Load from 5D 3
Rstr SD Rslt= Idle After loading from sD
Rstr Factorys= No P restart required b
Save Params= No b
Rstr Params= No b
OK oK
€ e ¢ e ssc (

Figure 96 The Save/Restore menu could look different depending on software version

INFORMATION
Parameter files are now written to the SD card.

Two PARAM files one in “UCF” and one in “BIN” format are stored on the SD card. Copy and
save these files into a new directory in the PC
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b) SD-Card Software Update Procedure

1. Upload all unzipped files of the software to the root of the formatted SD card.

WARNING
/!\ SD Card must contain only software .ucf files

$e > QuesioPC  SOHC (D) v{ 0

U] ATLAS_3.09.8_Code_687.uct
7] ATLAS 3.09.8_HMLucf

7] ATLAS 3.09.8_0BH_687.uct
[l ATLAS 3.09.8 Scope.uct

_] ATLAS 3.09.8 Web.ucf

"] POL68T_BSP_V1036.UCF

Figure 7 Example of software unzipped in the root of the SD card

2. Insert SD-Card in the Controller dedicated SD card slot with controller “On”

SIEMENS

Figure 8 Controller dedicated SD card slot

3. Turn off power to the controller.
4. Insert the pin in the dedicated slot and gently push the internal reset button

Figure 9 Controller dedicated pin slot

5. Keep the button pushed with the pin and give power to the controller.
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INFORMATION
During this phase BSP led blinks green
6. When the BSP led starts blinking red and green stop pushing the pin.

P L LT

-
> (@
—

o . B ) e

Figure 100 BSP Led flashes red and green during software upload

A4 d

7. When BSP led is fixed orange, immediately remove the power from controller.

e I

o
=1(¢)
——

[, [ -

o . (A P EJIEs

Figure 101 BSP Led becomes orange when software upload is completed

BSP BUS

8. Give power to the controller

WARNING

(*) At the first start of the controller after the software update, if there is installed any
communication board (Modbus, Bacnet, etc...), it is very important to wait an automatic
uploading of the communication board too. The communication board software update will

start automatically once the controller has started and main board will be restarted when the
update is completed.

9. We strongly suggest repeating the upload procedure (point 2 till 7) twice to guarantee a complete software

upload
10. Once the software upload is complete and the controller restarted, check in the About Chiller menu that the

actual software version corresponds to the one just installed.
In case the software version does not correspond, check that you have the correct software version for the

controller copied on the SD card and repeat point 2 till 7.
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About Chiller 4
Unit Serial MNumber
Enter Data
Software ATLAS
3.09.B
BSP 18.36

Figure 102 About Chiller Menu

c) SD-Card Restore Parameters
It's possible to perform a copy of the old parameter settings using the Restore Parameter function as following

On an empty SD card, copy the files PARAM.UCF and PARAM.BIN

Insert the SD card into the controller card slot.

Insert technician password

Goto Save/Restore menu

If the SD Card appears in the menu, check that the SD Card status shows ReadWrite otherwise check that
the SD is well inserted or replace the SD card. If the SD Card is not shown, then the software does not have
the SD Card compatibility test function. In this case just go to step 12.

6. Use the "Restore Parameter" - "Full” functionality to download the PARAM.UCF file from SD Card to
controller.

agrwhPE

INFORMATION
Depending on software version, the string of restore parameter functionality can be different.
Refer to table in the appendix to use the correct string. Possible strings are:
e Rstr from file
e Rstrfrom SD
e Restore Parameters
e Load from SD

I |save/Restore b ! |save/Restore 4
SD Card ReadWrite SD Card Readwrite
Software Update Idle b %o Software Update Idle b
Save Parameter No P > :::"‘ Save Parameter No 3
Status Idle Status Idle
Restore Parameter No Restore Parameter No p
Status Idle} Status Pass|
Save Memory No P Save Memory No P
Reset Defualt No b . Reset Defualt No b .
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Ll ° |save / Load 3
sD Card NoCard >
Save Params 3
Load default 3
[Load from sD b |
After loading from SD
restart required 3
AN ESC

Figure 103 Save/Restore menu may be different, it depends on the software version

a) The restore parameter function is successful if the Status changes from Idle to Pass.
b) If the status Fail pops out repeat the step 6.

7. Recycle the controller by removing the power supply or select "Apply changes" to restore actively the
parameters, for the AHU select “restart required” in Save/Load Menu

8. Since the parameter update is done in 2 stages, it is necessary to repeat the Parameter Restore procedure
(from point 2 till point 7) 3 times to guarantee a complete upload of the parameters

INFORMATION
E] In case the restore procedure fails, all the parameters are set as default.
So, unit, circuit configuration, alarm limits, sensor calibration, compressor run hours and starts,
frequency parameters are anyway possible to update manually.
In case parameters are lost, refer to service support for correct unit configuration.

CAUTION
To double check the parameters already copied, verify each setting according to the Manual
Configuration procedure

7.3 Update using Scope Light Application
a) Scope Light Application

a) Open the Climatix Scope Light application on your PC.

Climatix Scope Light

Figure 104 Climatix Scope Light Application

b) If the protocol window appears, just close this window by clicking on the X mark on the top right corner
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I8 Octavittight - Climatix SCOPE (Lig
Bves- § 20
| s [ S0 |

SIEMENS

h

it n}
[ & § Connect ~ Serial

3

Date Level Flomaten

A20331 U205 o Aopication Sate changed
20N WU o Appicatin Sute changed
020331 U408 o Appicaton Rate changed
020331 U500 o Apphcation State changed
0220331 42308720 o Connection State is reset, |
31 W2 8 Warnrg " b

20331 142317637 o Connection State i establa
A2 UBITHE o Conection establshed
02033 WB7ER o Appicaton e changed
A2WNUDBNT o Appicaton Qate changed
22033 UAUNTH  Wo Appication Sute changed
20331 U498 o Cornection State s rese. |

| woneintquesy D s

0220331 142040700  Info Connection Sate is no con
T MANMN?  Wanng crect e
2220331 14244074 o Connection chosed
ARVINUNUE o Propect saved
220N UNUBE o Project saved
20331 DUV o Comection tute s extabln
220N UNUIB o Connection establshed
203N WNHE2 o Appication e changed
220331 14530000 o Project saved
N2 VAR o Profect saved
2040217250154 o Proect saved
2040217251347 o Propect saved
ND0217275276 o Propect saved

20220131 081800 ARURTNNE o Project saved

Comp  ADAMI0GAM. 2022013108358 BS4S4AIANB4IRA AR ITAIRTI0 o Project saved
Mwprglomp ADAMI06A0. 2220131084332  FOMXA2DCE34AIS.. 2204021745096 o Project saved

HMdWeb  ADAMIOBA. 2020131083706 GEICFFSD-20ACHCES.

IR

UghtVerson- ADAM 306AS..  202109-30 08:00:10 4B153C82D478-L0759

Figure 105 Main window in scope light

b) Siemens POL 638 Controller to PC connection

INFORMATION
In this paragraph, scope light controller connection with USB-B cable is explained. For Ethernet
cable connection refer to Paragraph 7. Scope Light — connection by ethernet cable

a) Go to the Settings Tab:
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E DefaultLight - Climatix SCOPE (Light)
‘@@Menu- B [ F 9 ™ L) ¥ | § Connect ~ POL638 05B4A3 ~ USB

mesnnn

§% Setings (] Startup |

EEEEEERE W

W

Figure 106 Scope Light settings menu

b) From the Target dropdown window select POL 638
c) From the Interface dropdown window select USB

INFORMATION
In this menu it can be selected the type of connection is intended to use; in this tutorial the USB
connection is explained.

Figure 107 USB-B Cable for POL 638

d) Click on the Save All Tabs to save the current settings.
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K] pefaultLight - Climatix SCOPE (Light)

LTRSS B Skl © § Connect - POLG3805B4A3 - USB
—_— .

4% Seitings [ Statup H““:ahi____q_h_

Communication C-ﬁi’ﬂ@we

POLE3E_05B4A3 w

b) Select POL 638

Vd ---\‘\\
(c) Select USB )
\x___ //'

Figure 108 Communication Settings

e) Connect the USB-B cable from the PC to the Siemens Controller
e f s e
20| |22 0R00Q)| @22 (@022 (@2
Fodeettetdatiad AT el iedieiis]fe
= = =2 oo = X 9 = " = E = o= ¢ 5 =T 83 =32 8-= N
SIEMENS
Ao AN — s — (-1 ) uss e ) SO 8
® 5 & =, .| #2 g -
QPR DD2Q| @22 Q)| |le@@
Port T-5V USB to T-SV Cable
Figure 109 USB Connection
INFORMATION

Once the cable is connected, automatically the Siemens controller drivers are installed on the
PC. This operation usually takes just a couple of seconds. When driver installation is done, the
POL638 device becomes available in the Device dropdown menu.

f) Select POL638 from the Device dropdown menu
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 @@Menu - | (10819 © [k i 1§ Comnect Hpoiessoseans T USB|
4% Settings |
Communication Current Language
Target: | POL6X _— — v|  [Application v
interface: |fEEN _hﬁ:lick Connect B | - Engieaning Unt Sugport
AN S/ - -
e enable v
USB
Export Cache
Device: £ POL638_05B4A3 v
e ssssssssEEsEEEsEEEEEsEEEEEEmEEE
Auth: | |

from the Dropdown

g) Select POL638

Menu

Figure 110 Connection Settings

E-j DefaultLight - Climatix SCOPE Light (Light)
#@Menu~ [ ] # |9 & | I §g Disconnect ~ POLG38 05B4A3 USE
/ﬁ Settings ]
Communication Current Language
Target: | POLEX v [Applcation |
TERTE |USE v| Engineering Unit Support
|enab|e V|
UsB
Export Cache Files
Export
Devies:  |POLE38_05B4A3 v | Ewot |
Auth: | |
Please enter your PIN
|oooﬂ |
Protocol [ok ] | cancel | |
@' Date Level Information Logger
|| 2022-07-11 09:18:13.772 Infa Project saved Project
E” 20220711 09:18:13.914 Infa Project saved Project
E 20220711 09:18:15,113 Infa Connection State is establis... Project
2’| 202207-1109:18:15327  Info Connection established. Project
20220711 09:18:15.451 Infa Application State changed ... Project
20220711 09:19:12,051 Infa Project saved Project
20220711 09:19:12,136 Infa Connection closed Project

Figure 111 Daikin PIN

Click on the Connect Button

9)

h) Put the Daikin Service Password when asked for the PIN
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INFORMATION
On board controller: when connecting controller, parameters are read by Scope Light. Before
proceeding with any action on Scope Light, the parameter reading process must be completed.

Figure 112 Scope reading parameters

c) Scope Parameters Save procedure

a) On the project page, click on the Parameter Up — and Download then click on the Target -> PC button

=1 DefaultLight - Climatix SCOPE Light (Light) _ O w
M- B [ B ' | |d k¥ |} §p Disconnect ~ POLE3B 0SBAA3 USB

Project * B|| % Sefings |5 CorfigPrject ' Parameter Load* 4bx
=) Ej DefauhLight Parameter Loading

Restare Selection J PC Taget 4 Tamget>PC
@Mmmmﬁmmmen'bem

() All object instances with all members
() Only instances from type:

Start Parameter Download

i .z Parameter Up- and Dowrboad
| ;E'Dc-cmrema!m

i & Watch Pages -
{5y Schedulers Deseription File Time Type
L€ Calendars EEFAPAIIGAEEEE | ParameterPOL.. - mage
= Trend
L Onine
£l areivee
Choose the Parameter file
Protocal —
Level Infoemation Lagges —

711091943565  nfo Project saved Project
09:19:44.075 nfo Project saved Project

uorInbiuosy ;f_}

nfo Connection Stale is establs Project
Info Connecton established Project
Infor Bpplication State changed ... Project
infn Proiert saverd Prmimct

Figure 113 Parameter Up — and Download
b) A new file will appear on the window below and it is possible to choose the name of this file. Confirm the

name by pressing enter on the PC Keyboard and the parameter download procedure starts. The procedure
is completed when the progress bar goes to 100%
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[ DefauliLight - Climatix SCOPE Light (Light) - o x
@Menu - [ [ B9 & I il §ig Disconnect ~ POLE38_05B4A3 USB
| Project = 8| i Seings [ CorfigProject ' 7 Parameter Load* 1bx

Parameter Loading

Once parameter file name is
«tergonfirmed with the enter buttom
“~___ the procedure starts

Descroton, 2~ Fle Time Tive

Parameter-POLE3E... Parameter-POL.. - Image

1

v e x
2| Date leve  ifomation Logger -
2| 20220711 092009135 ko Connection closed Project
= || 20220711 09.2009.267  If Cormection State is r Project
S || 2022-07-11 03:27:57.700 w: P:;,ea :ued e PZm PrOB ress bar
g || 2022.07.11 09:27:57.003 ko Project saved Project
— | 20220711 09:27-58,176 Info Connection State is establis... Project
2022 09:2756.228  Info Connection established Project
020711 92758307 o Aopication Sute changed .. Project
20220711 09:34:1942% ko Parameter Parameter-POL. Para... v
[, Ao | {9 Protocol [ Loader
Figure 114 Parameter Up — and Download
d) Scope Software upload procedure
a) Enable the Loader window by going to: Menu > View->Loader
E] Defaulttight - Climatix SCOPE Light (Light) POL38_05B4A3 — o w8
(i@ Menu || [ ] # | 9 ™ || g Disconnect ~ POLE38_0SB4A3 USB
Project » = 0| = setings 40X
Recent Projects  » | Communication Cument Language
Application » Target: | POLE ¥ Applcaton bt
View L8 steup Alt-S ¥ Engneering Unt Support
@ Help » |69 Settings F2 enable »
B it L] aam At
T Protocol Alt=P
-4 Data Points N eadar iy
-2 Parameter Up:
|- 43 Documentation Restore Default Layout  Alts
|, Watch Pages
(1) Schedulers
L] Calendars
= [l Trend
Il Onine
€| Archive
: Enable Loader
. window
Protocel E———
Date Levdl  Iomation Logger v ~
20220711 09:2009.267  Info Connection State isno con..  Project
2022:07-11 09:2757. Info Project saved Project
20220711 09:27:57, Info Project saved Project
C[| 20220711 09:27:58.176 Info Connection State is establis Project
20220711 09:2758.228  Info Connection established, Project
20220711 09:2758.307  Info Application State changed Project
20220711 09:34:19429  Info Parameter ParameterPOL..  Para..
20220711 09:34:36.055  Info Parameter ParameterPOL..  Para.. v
A Mz | ) Protocel |[@ Loader
Figure 115 Enable Loader window
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] Defaultlight - Climatix SCOPE Light (Light) - [} *
(@@Menu- B [ B 9 © L] G §g Disconnect - POLGIB_05B4A3 USE
~ n| = Settings 40 x
|| Communication Cument Language
Target: | POLG3 ~| | Appheation v
Interface: | USB v E Unit S
- e v Software files
Cache Fies H
‘Gpat Cudnf window
=4 Data Poirts Device: 25
: Parameter Up- and Download
|1 Documentation L
|-, Watch Pages
=) Schedulers
| & Coin Loader Control
=l Trend
- | P S
Loader Control PULLon

Target GUID Message
E4902454-8243-46D5-5C 9C-FE22883D5088
632C4T8F-DF9B-4914-A132-B20AF2E16848

BSSAE158-2679-4F 77-BEF1-31 DCASES 3180
CDES1ATS-4DOE-4CD3-3010-55D4239CAEFD

Applicaion  MBRTCode ucf
HMICrf-Comp  HMlcomp uct
Mapping Comp  DBHVNcomp.uct
HMI4Web HMI4Web uck
BACnet Client  BACnetcsv
Light-Version-...  ScopeConfig uct

Load Cancel f
FumEnaE

o Az | i Protoc® | @ Loader :
I

Figure 116 Loader Window

b) Double click on the first raw in the Loader Window
The Browse window will appear

c) Copy the output folder address to be able to create a shortcut of this folder on the desktop. In this folder
we need to copy the Software files later.

B Defauitight - Climatix SCOPE (Light) - a x
BAMew- BB 9 > L | i Disconnect + POLEST 093388 USE
[ Prrect @ | & Saunce i x
o ) owarin = =
i: Setrgs Taer: | POLEST | |Aophcaton [ erowse for Application - o X
T i!ﬁo.ea btetaos: I d Engneenng Unt Suppot.
< Foatte —
- use

@ Tee oot Cche s

& oo Doven: PO = B
& Parameter Up- and Download
# 7 Documantation p ———1
@ e rages
@) Scheduiens
ooy

-
o ¢ he O

Douhle click on opy the Output
oné of the 6 folder address
rows

X 2022- 58
4 MagpingComp ADAM 3.06.4_OBHES7.uck 20220131 084322

A HMiawet ADAM 3.06.A_Webuch 202240131 08:37:06
[]BACnet Chert  BACha cav - -
A Ught-Version-. ADAM 3,06 A_Scope.uct 20210530 08:00:10 4B156CE2DATE4075-9.

89 towcer [ 2 A

Figure 117 Copy Output directory

d) Open the file explorer on your computer and paste the Output folder address in the address bar
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M 7 s | Output - o x
[r [ — e
« v 4 (C:\Users\andrei.balan\AppData\Local\SBT\Ra Scope\DefaultLight\Output vio £ Cerca in Output
a - Daikin Applied ~
OneDrive - Daikin Applied Europe S.p.a ~  Nome Ultima modifica Tipo Dimensione
% Questo PC

] ATLAS_4.03.A_Code_687.uct 4/03/2022 07:44 File UCF 440 KB

W AppleiPhone | ATLAS_4.03.A_ HMLucf 22 09:08 File UCF 82 KB
(BB Desktop J ATLAS 4.03.A_OBH_687.ucf 22 09:00 File UCF 76 KB
5 Documenti [) ATLAS_4.03.A_scope.uct 23/12/2020 16:22 File UCF 30 KB
& Download ] ATLAS_4.03.A_ Webucf 02/03/2022 09:08 File UCF 365 KB
& Immagini | POL687_BSP_V1036.UCF o/05/2019 18:27 File UCF 3.043 KB

D Musica
B Oggetti 3D
B video
% Disco locale (C) Paste the Output folder
@ Rete address on the address bar
of the File Explorer
6 elementi ==

Figure 118 Paste the output folder address in the address bar of the File Explorer

e) Create a shortcut of the Output folder on your desktop

v | Output Crea collegamento in Desiiop

Mome  Condwidi  Visuiaza
2 £

Comnencenre - (IR 210026 11
@ OneDrive - Daikin Applied Europe Spa
ATLAS_403 A Code 687.uct
ATLAS_403A HMIuct
B Apple iPhone ATLAS_4.03 A OBH_687.ucf
B Desktop ATLAS 403A scopeaxt

% Documenti ATLAS_403A Web.uct
# Download POLEB7_BSP_V1036.UCF

= Questo PC

& Immagini
D Musica
2 Oggetti 30

::::wm Drag And Drop the Output

@ Rete folder to create a shortcut
of this folder on Your
widows desktop

6 element

Figure 119 Create Output folder shortcut

f)  Open the shortcut of the output folder from desktop. Make sure to delete all existing files and copy in this
folder only the unzipped files of the software you need to update on the Siemens Controller.

g) From Scope Light Loader Control window select now the files to be updated on the Siemens Controller:
Double Click on the raw of Loader window and when the browse window appear, select the file

DAIKIN APPLIED EUROPE S.p.A.

Societa unipersonale soggetta ad attivita di direzione e coordinamento di Daikin Industries Ltd

Sede Legale/Operativa: Sede Operativa: Sede Operativa: 5
Via Piani di S. Maria, 72 Via Giuseppe di Vittorio, 8 Via Giuseppe Ferrari, 31/33

00072 Ariccia (Roma), Italia 20090 Caleppio di Settala (Milano), Italia 36100 Vicenza, Italia

T +3906937311 Cap.soc. € 10.000.000,00 i.v. R. 1. RM/ C.F. 04878860586

F +39069374014 PEC: dae@pec.daikinapplied.eu R.E.A. 467651 - P.1. 01318801006 65


mailto:dae@pec.daikinapplied.eu

P"DAIKIN

[ Defaultlight - Climatix SCOPE Light (Light) - O X
@@Menu - (B [ 8|9 ™ |[J il i §g Disconnect - POL638.05B4A3 USB
Project v 2| i Settings | 4k x
o [ Defeuitighe ~ || Communication Curent Language
&, Seftings Target \POLG& "| [ Browse for Application - o x
= ¥ Configuration - y
T e Interface: | USB v [E e ance baan FppDaa Local SHT Farbow Scope Delak T 0 ]
&= Foot MNote Fies Modied Size
W Target uss ATLAS_403A Code 687ucf 20220304 07.44:16 w0KB
(%) Time
<% Diagnostics

=) Data Points
- 2% Parameter Up-and Dowrload
b Auth

-[# Documertation .

B Wt er 1)/ Double click 2)Copy the

Q) Sheden r|lone of the six output folder
—— address

" Files BSP Auto Upgrade

Type File: Time: GUID drget GUID mmemae
Application MBRTCode.ucf = = ABB19093-3DA7-4EBD-8AA3-3ECAZAFECICC
[ HMICrfComp  HMIzomp.uck - - BC7BBEA0-20D5-4393-A7BC-EB48521FBFEF
[ MappingComp  OBHVNcomp.ucf - - AIINAQCT-837A-4372-BOB2-E114EFCEEETT
[ HMi4we HMI4Web ucf - - 18D9D0E3-BC2B-44F3-9B59-57A43071E1FD
[] BACnet Client  BACnet csv - - -
[ Light-Version-... ScopeConfigucf - - TB277CE1-411E-4543-A521-156C84118E56
Load Cancel

i Wam | @ Protocol | @ Loader |

Figure 120 Select software files

h) Repeat “step g” for all the remaining files: HMI-Cnf-Comp, Mapping-Comp, HMI4Web, Light-Version-
Config except BACnet Client, until all the software files are selected

i)  Before the update can begin, the application on the controller needs to be stopped. To do so the controller

can be updated.
To stop the controller application, go to: Menu - Application-> Stop

K] Defaultlight - Climatix SCOPE (Light)

@Menu~| ] ) 2 9 & L) o Disconnect ~POLG38 05B4A3 USB
[ Project » - gi +3 Settings
Recent Projects  » Communication Current Language

O St Target:  POL63x v | | Application v

O stop intedface: |USB B & leas

[ Stop apph:«}h%m\n target system ]

top the application on the
Siemens controller

Figure 121 Stop controller application

INFORMATION
The controller enters in software update mode: the display will be OFF and the BSP led Orange
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HENE|RREERERN|ERRRRNRR|EREEE [I|_L_|

O
Display OFF D @
D

i BSP BUS
H b B U

Figure 122 Controller in software update mode

j) If the Connection to device has been lost! Window appears, press OK and recconect again to the
controller.

Climatix SCOPE

) g Connection to device has been lost!
| |

Show this message again

Figure 123 Connection lost warning

INFORMATION

After the application stops on the controller, this could result unavailable on the Scope Light
Application, and it could be necessary to disconnect and reconnect the USB cable until the
controller becomes again available and is possible to reconnect by clicking on the Connect
button.

U Connect -~ + USB Connection to device has been lost!

Unplug and recconect the USB until
the controller is again available

@ Connect - JoJIGERIEI:ZYEY - USB Connection to device has been lost!

Figure 124 Controller not available
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k) Once reconnected, a warning window will reappear to let you know that the application has been stopped
on the target (controller). Acknowledge this warning by pressing OK.

Project hd

e Application on target stopped or not loaded.

Figure 125 Application stopped warning

I) It's possible now to start software update by clicking on the “Load” button on the loader control window.

Fles | BSP
Tywe File Time GuID Target Message
EA Application ATLAS_4 .03 A_Code_687.uck 202203-04 07:44:16 F4D04DCD-23A2-42AE-
& HMI-Crf Comp ATLAS_4.03.A_HMIuct 2022-03-02 09:08:14 9ASC1050-64B145C3-8. (- Start Software update
A MappingComp ATLAS_4.03.A_OBH_687.ucf 20220302 09:00:54 2DDFB21D-D707-47DB-... -
B4 HMiawes ATLAS_4.03.A_Web.ucf 20220302 09:08:26 DOICFA1A447E4SED-

Figure 126 Start Software Update

m) The software update is completed when on the Message column all the voices show “completed”

Fies | BSP |

Type Fle Time GUID Target GUID

Application ATLAS_4.03 A_Code_687.uct 20220304 07:44:16 FADD4DCD-23A2424E-.. - Completed

4 HMICof-Comp ATLAS_4.03 A_HMlucf 20220302 09:08:14 SASC1050-64B145C39... - Completed

[ Mapping Comp ATLAS_4.03.A_OBH_687ucf 20220302 09:00:54 2DDFB21D-D70747DB-.. - Software update Completed

HMI4Web ATLAS_4.03A_Web.uck 2220302090826 DOICF41A447C4IED- . - Completed Completed

[] BACnet Client BACnet csv - - -

[ Light-Version Config ATLAS_4.03.A_scope ucf 2020-12:23 16:22:28 DESEFAC2-4T1A4CS8A.. - Completed

[ Load Cancel

Figure 127 Software update completed
n) Restart the application on the controller by selecting Menu - Application > Start

DAIKIN APPLIED EUROPE S.p.A.
Societa unipersonale soggetta ad attivita di direzione e coordinamento di Daikin Industries Ltd
Sede Legale/Operativa: Sede Operativa: Sede Operativa: )
Via Piani di S. Maria, 72 Via Giuseppe di Vittorio, 8 Via Giuseppe Ferrari, 31/33 +* )
00072 Ariccia (Roma), Italia 20090 Caleppio di Settala (Milano), Italia 36100 Vicenza, Italia
T +3906937311 Cap.soc. € 10.000.000,00 i.v. R. 1. RM/ C.F. 04878860586

F +39069374014 PEC: dae@pec.daikinapplied.eu R.E.A. 467651 - P.1. 01318801006 68


mailto:dae@pec.daikinapplied.eu

' DA ’K’N INTERNAL USE ONLY

K DefaultLight - Climatix SCOPE (Light)

A Menu I SHBE' JK Ld ' §p Disconnect ~POL638 05B4A3 USB
I Project »
Recent Projects » Curent Language
[ Rophction [ s ) osen =
View » >top v E Unt S
© Hep » [ Start 3PP"<&}\Q\\Cn target system I G
@ Exit

Device: POL638_05B4A3

Auth

Start Target Application

Figure 128 Start Target Application

0) Once the software upload has completed and the controller restarted, check in the About Chiller menu
that the actual software version corresponds to the one just installed. In case the software version does
not correspond, check that you have the correct software version for the controller copied on the output
folder repeat the software update procedure.

About Chiller 4
Unit Serial Number

Enter Data
Software

B5P 1a.36

Figure 129 About Chiller menu

p) Once the software is successfully updated, it is possible to restore the parameters on the controller.

e) Scope Parameter Restore procedure
a) From the Project page click on the Parameter Up- and Download
b) Step 1) Select the option All object interface with all members
c) Step 2) Select the desired parameter file
d) Step 3) Click on the PC->Target button and confirm the parameter upload
e) Parameter upload procedure finishes when the progress bar arrives at 100% and disappears
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[ pefaultLight - Climatix SCOPE (Light) - o x
AMenu - B B kd [ | §ip Disconnect ~ POLG38 058443 USB
Eivject v B | §% Setings ' 7 Parameter Load" T
] petauruigne Parameter Loading
&, Settings Restore Selection $ PCoTagat 4 Target > PC
& § Configuration O Alinstances with mandatory members Step 3) Start Parameter upload into
>
c’l Pr:::a, @ Al cbject instances wah all members the controller
S W Tooet © Only instances from type:

® e o
- Diagnostics Step 1) Select All object interface

5@ Data Ports with all members
& Parameter Up- and Download
# % Documentation
B, Watch Pages
5 Scheduers Description Fle Time Type
€ Calendans Parameter ParameterPOL . 20220403 . Image

[ Trend parameter 2 Faramerer o 5
M Onine parameter 3 Parameter-POL. Progress bar
| Archive Step 2) Select the desired parameter
files
L i [=]

Figure 130 Parameters upload procedure

f)  Recycle the controller by removing the power supply or select "Apply changes" in menu Commission Unit
- Configuration - Unit > Apply Changes = YES to restore actively the parameters, for the AHU select
“restart required” in Save/Load Menu.

g) Since the parameter update is done in 2 stages, it is necessary to repeat the Parameter Restore
procedure twice

h) The Software update and Parameters restore procedure are completed.

INFORMATION
In case the restore procedure fails, all the parameters are set as default.
So, unit, circuit configuration, alarm limits, sensor calibration, compressor run hours and starts,

frequency parameters are anyway possible to update manually.
In case parameters are lost, refer to service support for correct unit configuration.
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8 POL 468

8.1 Description

UL

POL468.65/STD
55! 0

5394.C686 F 101

Figure 131 (A) POL 468

@ (b)

ST
AT

(©)
(d)

LEDs for diagnostics

I|||II|HI>

UL

Figure 11 BSP BUS LEDs
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e LED BSP "Run/ Stop": 3 colours (green, red, and orange)

SW update mode (download application or firmware) | Every second alternating between red and green
Application loaded and is running Green on

Application loaded, but not running Orange on

Application not loaded Orange flashes: 50 ms on, 1000 ms off
Firmware error Red blinking at 2 Hz

Hardware fault Red on

Table G LED BSP meaning
8.1.1 USB-Drive specifications
e Type:USB 2.0
e Maximum: 32GB
e  System: FAT32
e  Current: 100mA

a) How to check if USB is supported SERVICE INTERFACE

Not all the software has this option, but most software will allow to check the compatibility of the SD card with the controller
by following this procedure:

a. Insert the service Password
b. Go to the Save/Restore menu
c. Insert the USB-Drive in the dedicated slot.

3
=
=

2
=

Figure 12 Compatible USB-Drive message

e If the SD Card status shows ReadWrite then the USB-Drive is supported

INFORMATION
For some software version the string that verifies the status of the USB-Drive, is named “SD
Card”
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! |save/Restore 3
sD Card ReadWrite |
Software Update Idle
Save Parameter Mo
Status Idle
Restore Parameter No b
Status Idle
Save Memory Na
Reset Defualt Mo -

Figure 13 Compatible USB-Drive message

e If the SD Card status shows NoDevice then the USB-Drive is NOT supported

Figure 14 USB-Drive

8.2 Update by USB-Drive (Service Interface)

INFORMATION
For NaYda Software, the service interface is available only from version 1.01A
For PEGASO Software, the service interface is available only from version 1.05A

1. USB-Drive Save Parameters Procedure (Service Interface)

1. Insert the USB-Drive into the controller USB-Drive slot

E
i
=
3

Figure 15 Controller dedicated USB-Drive slot
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2. Enter technician password
3. Go to the Main Menu - Save/Restore = "Save Parameter" = Yes

[] PARAM.BIN
[ pPARAM.UCF

Figure 16 The Save/Restore menu could look different depending on software version

INFORMATION

Parameter files are now written to the USB-Drive.
Two PARAM files one in “UCF” and one in “BIN” format are stored on the USB-Drive. Copy
and save these files into a new directory in the PC

2. USB-Drive Software Update Procedure (Service Interface)

WARNING
A For PEGASO Software use this procedure starting from software version 1.05.A or

following one
For NaYda Software use this procedure starting from software version 1.01.A or

following one

1. Upload all unzipped files of the software, to the root of the formatted USB-Drive.

WARNING
A USB-Drive must contain only software .ucf files
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v 0 2 Cercain Unita USB (D)

[] Mome Ultirna modifica Tipo Dimensione
D PEGASO_1.16.4_Code.ucf 19/05/2022 12:29 File UCF 282 KB
D PEGASO_1.16.A_HMIl.ucf 13/05/2022 16:33 File UCF S0 KB
[} PEGASO_1.16.A_OBHVN,ucf 13/05/2022 16:38 File UCF 30 KE
D PEGASO_1.16.4_Scope.ucf 13/05/2022 16:38 File UCF B4 KB
D PEGASO_1.16.4_Web.ucf 13/05/2022 16:33 File UCF 167 KB
D POL46x5TD_BSP_W1140.UCF 16/12/2021 17:33 File UCF 901 KB

Figure 17 Example of software unzipped in the root of the USB-Drive

2. Insert the USB-Drive into the controller USB-Drive slot

il bel i bam

Figure 140 Controller dedicated SD card slot

3. Enter technician password.
4. Go to the Main Menu - Save/Restore = Software Update = Start.

Figure 18 Software Update in Save/Restore menu

5. While software is updating, check the status of the LED:
Result: First the LED blinks green. Then it blinks green / red, and at the end it lights up continuously

orange
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6. Immediately turn OFF and ON the main switch.

WARNING

A Once the software has been updated, the service HMI will not work because the
parameters have been deleted. It is necessary to switch interface from EVCO to
SIEMENS.

7. When done, on the user interface or service, check the menu ->About chiller.
Result: Software version MUST be the latest version

Figure 19 About Chiller menu

3. USB-Drive Restore Parameters (Service Interface)

1. Enter technician password
2. While power is ON (LED = ON), insert the USB-drive containing the PARAM.ucf in the USB-port

3. Go to the Main Menu - Save/Restore - Restore Parameter 2 Full

Figure 20 Restore Parameter in Save/Restore Menu
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4. Go to Application Save (bottom of the main-menu) = Yes.

Figure 21 Application Save in Main Menu

Remove the USB-drive from the USB-port

Go to Commission Unit = Configuration = Unit = Apply Changes - Yes.

Since the parameter update is done in 2 stages, it is necessary to repeat the Parameter Restore
procedure (from point 2 till point 6) 3 times to guarantee a complete upload of the the parameters.

Result: The parameters are updated.

Noo

Figure 22 Apply Changes Menu directory

INFORMATION
In case the restore procedure fails, all the parameters are set as default.
So, unit, circuit configuration, alarm limits, sensor calibration, compressor run hours and starts,

frequency parameters are anyway possible to update manually.
In case parameters are lost, refer to service support for correct unit configuration.

CAUTION
A To double check the parameters already copied, verify each setting according to the Manual
Configuration procedure
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8.3 Update by USB-Drive (User Interface)

a) USB-Drive Save Parameters Procedure (User Interface)

INFORMATION
For NaYda Software, Save/Restore functionality in the user interface (EVCO) is available from

version 1.01A
For PEGASO Software, Save/Restore functionality in the user interface (EVCO) is available

from version 1.08A

1. Insert the USB-Drive into the controller USB-Drive slot

Figure 23 Controller dedicated USB-Drive slot

2. Enter technician password

WARNING
Check your software before proceeding, the user interface menu changes according to the
software version

3. Use the Save Parameter functionality to download PARAM.UCF file from controller to USB-Drive.

e PEGASO Software: Go to page [14.06] Parameter Save -On
e NaYda Software: Go to page [20.03] Parameter Save ->On

Software Pegaso

Figure 24 Save Parameter EVCO HMI
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4, Wait 20 seconds.
Result: The file PARAM.ucf is saved in the USB drive.

INFORMATION
Parameter files are now written to the USB-Drive.
Two PARAM files one in “UCF” and one in “BIN” format are stored on the USB-Drive. Copy

and save these files into a new directory in the PC

b) USB-Drive Software Update Procedure (User Interface)

INFORMATION

For NaYda Software, use this procedure starting from software version V1.01.A or following
one
For PEGASO Software, use this procedure starting from software version V1.12.A or following
one

1. Upload all unzipped files of the software, provided by the factory, to the root of the formatted USB-Drive.

WARNING
/!\ USB-Drive must contain only software .ucf files
w | @ 2 Cerca in Unita USB (Dx)
[0 Mome Ultirma modifica Tipo Dimensione
D PEGASD_1.16.4_Code.ucf 19/05/2022 12:29 File UCF 282 KB
D PEGASO_1.16.4_HMIl.ucf 13/05/2022 16:33 File UCF 50 KB
D PEGASO_1.16.4_0BHVM.ucf 13/05/2022 16:38 File UCF 39 KB
D PEGASO_1.16.A_Scope.ucf 13/05/2022 16:38 File UCF 84 KB
D PEGASO_1.16.4_Web.ucf 13/05/2022 16:33 File UCF 167 KB
D POL46xSTD_BSP_V1140.UCF 16/12/2021 17:53 File UCF 901 KB
Figure 25 Example of software unzipped in the root of the USB-Drive
2. Insert the USB-Drive into the controller USB-Drive slot
| ————————
I
|
|
|
l o
Figure 26 Controller dedicated SD card slot
3. Enter technician password
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WARNING
Check your software before proceeding, the user interface menu changes according to the
software version

4. PEGASO Software: Go to page [23.02] Software Update ->On
NaYda Software: Go to page [20.02] Software Update ->On

Software: NaYda

Figure 27 Software Update EVCO HMI

5. While software is updating, check the status of the LED:
Result: First the LED blinks green. Then it blinks green / red, and at the end it lights up continuously
orange.

6. Immediately turn OFF and ON the main switch.

7. When done, on the user interface, check the menu —About.
Result: Software version MUST be the latest version.

c) USB-Drive Restore Parameters Procedure (User Interface)

INFORMATION

E For NaYda Software, Save/Restore functionality in the user interface (EVCO) is available from
version 1.01A
For PEGASO Software, Save/Restore functionality in the user interface (EVCO) is available
from version 1.08A

1. Enter technician password
2. While power is ON (LED = ON), insert the USB-drive containing the PARAM.ucf in the USB-port

WARNING
Check your software before proceeding, the user interface menu changes according to the
software version

3. PEGASO software: Go to the page [14.07] Parameter Restore = 2
NaYda software: Go to the page [20.04] Parameter Restore > 2
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Software: PEGASO Software:NaYda

Figure 28 Parameter Restore EVCO HMI

4. PEGASO software: Go to page [23.00] Application Save = On
NaYda software: Go to page [20.00] Application Save ->On

Software: PEGASO Software: NaYda

Figure 29 Application Save EVCO HMI

5. PEGASO software: Go to page [23.01] Apply Changes -On
NaYda software: Go to page [20.01] Apply Changes = On

6. Since the parameter update is done in 2 stages, it is necessary to repeat the Parameter Restore
procedure (from point 2 till point 5) 3 times to guarantee a complete upload of the the parameters

Result: The parameters are updated.

Software: PEGASO Software: NaYda

Figure 30 Apply Changes EVCO HMI

INFORMATION
In case the restore procedure fails, all the parameters are set as default.
So, unit, circuit configuration, alarm limits, sensor calibration, compressor run hours and starts,

frequency parameters are anyway possible to update manually.
In case parameters are lost, refer to service support for correct unit configuration.

CAUTION
To double check the parameters already copied, verify each setting according to the Manual
Configuration procedure
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; 8.4 Update by USB-Drive (Manual)

WARNING
It is recommended to use this procedure when the controller is not powered by the machine

1. Save Parameters by user interface or service interface (SEE PREVIOUS PARAGRAPH)
2. Insert the USB-Drive into the controller USB-Drive slot

s
R

LED BUTTON

Figure 31 POL468

3. Press the button. And keep pressed
4. With the button still pressed, turn ON the main switch and power the unit
Result: The LED blinks green
5. Keep the button pressed
Result: The LED blinks green/red
6. Immediately release the button
Result: The LED lights up continuously orange
7. Immediately turn OFF and ON the main switch
8. Check if the software version is updated by user or service interface (SEE PREVIOUS PARAGRAPH)
Result: Software version MUST be the latest version

9. Restore Parameters by user or service interface (SEE PREVIOUS PARAGRAPH)
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8.5 Update using Scope Light Application
a) Scope Light Application

a) Open the Climatix Scope Light application on your PC.

Climatix Scope Light

Figure 155 Climatix Scope Light Application

b) If the protocol window appears, just close this window by clicking on the X mark on the top right corner

S|

AMens - H 2 kd 9 Connect ~ Serial
o Seanp [ Setw 1bx
A
¢ SIEMENS Rt
\ Creste Project

Recent Projects £ Dste levd  Fomaton Logger ”

Close Protocol
Window

[] Qiose page aer project load
] Show page on st

Lot il : e vd X

Fies | BSP ©

Type Fle

2 opkeaton

Figure 156 Main window in Scope Light
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b) Siemens POL 468 Controller to PC connection

INFORMATION
In this paragraph, scope light controller connection with Micro-usb cable is explained. For
Ethernet cable connection refer to Paragraph 7. Scope Light — connection by ethernet cable

a) Go to the Settings Tab:

S|
AMenu~ § ) 2 L @ Connect - POL4680DI939  ~ USB

.:L...* Settings [:j Startup

Click on the Settings
Tab to access the
communication page

Figure 157 Setting window

b) From the Target dropdown window select POL 46x
c) From the Interface dropdown window select USB

INFORMATION
In this menu it can be selected the type of connection is intended to use; in this tutorial the USB

connection is explained.
The USB to RJ45 service cable is available as a Daikin Spare Part: PN 10000109500

Figure 158 Service USB Cable P.N. 10000109500

d) Click on the Save All Tabs to save the current settings.
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5 DefaultLight - Climatix SCOPE Light (Light) = O X
s
BMenu - | [ B |9 ™ lLu | figDisconnect ~ POL468_0D1939 USB /—\
i—
| Project v 3| §% Settings b x
= ﬁ DefaultLight Communication

d) Saves all tabs

L. %) Settings Target: :
=] i‘,’ Configuration ]
B Project Interface: 1 | USB i Eni iag Unit Support

i....q@ Foot Note enable v
a8 i‘ Target UsB

: .(::] Time Export Cache Files

i..9» Diagnostics
- Data Points Device: POL468_0D1939 ~

; 3 Parameter Up- and Download
\...#¥, Documentation

Watch Pages

-} Schedulers

£ Calendars

= Trend

..l Online

! /’_" Archive

Auth: |

b) Select POL 468

c) Select USB

Figure 159 Communication settings

e) Connect the USB - RJ45 cable from the PC to the Siemens Controller

USB to RJ45 Cable

PORT T-HMI\

0O -o
%E’O S

Figure 160 USB connection cable

INFORMATION

Once the cable is connected, automatically the Siemens controller drivers are installed on the
PC. This operation usually takes just a couple of seconds. When driver installation is done, the
POL468 device becomes available in the Device dropdown menu.

f)  Select POL468 from the Device dropdown menu
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E DefaultLight - Climatix SCOPE Light (Light)

@M - B9 ™
::'Seﬂﬁ!p /f/
O
intedace: | USB (h) Click Connect\)

@ Connect ¥: POL468_0D1939 ¥ USB

aransssssssastananassnansnnnnnnns

usB

Device: £ POL468_0D1939 v

S EssssssssEEEEEEEEsssssEEEEEEEne

Auth: |
g) Select POL468
from the Dropdown
Menu
Figure 161 Connection Settings
@Menu~ F [ (B 9 & L] I §g Disconnect ~ POL468_0D1939 USB
¥ Settings
Communication Cument Language
Target:  POL46« v Applcation v
Inteface: USB v Encineering Unit S
enable v
use
Expart Cache Files
Device: POL468_0D1339 ~ L
Auth: ]

Please enter your PIN

(Joedl )

P —

[Cox] [

Figure 162 Pin = Daikin Service Password
g) Click on the Connect Button

h) Put the Daikin Service Password 6363 when asked for the PIN
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INFORMATION
ﬂl On board controller: when connecting controller, parameters are read by Scope Light. Before
proceeding with any action on Scope Light, the parameter reading process must be completed.

Figure 163 Scope reading parameters

c) Scope Parameters Save procedure

a) On the project page, click on the Parameter Up — and Download then click on the Target -> PC button

" & Defaultlight - Climatix SCOPE Light (Light) - ] X
@Menu - |H [ 2|9 ™ || k¥ : §g Disconnect ~ POL468_0D1939 USB
[ Project +~ 2|/ 2 Parameter Load" | 3% Seftings _ 4bx
=[] Defauitlight Parameler Loading
- ® Seftings Restore Selectio & PC > Target ﬁ Target -> PC

Start Parameter Download

: ‘;P Diagnostics

3@; Data Points

& Parameter Up-and Download
-8 Documertation Enabled Objects

1 Watch Pages

Description File Time Type

-

Figure 164 Parameter Up — and Download
b) A new file will appear on the window below and it is possible to choose the name of this file. Confirm the

name by pressing enter on the PC Keyboard and the parameter download procedure starts. The procedure
is completed when the progress bar goes to 100%
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" Defouttight - Climatix SCOPE Light (Light) - o X
#@Menu~ |H ] 2 & |d k¥ §o Disconnect ~ POL468_OD1939 USB
Project v 8 | 2 Parameter Load" ({3 Setings | 4bx
= @ DefaultLight Parameter Loading
- Settings Restore Selectior PC > Target Target > PC
8 E’Mmon wandatory members Ak & Tk
B Project
&> Foot Note
o (Tg)g:m Once parameter file name is
# Diagnostics confirmed with the enter buttom
@ Data Points the procedure starts
& Parameter Up- and Download
[£3 Documentation
8, Watch Pages
Q: Schedulers Description File Time Type
€ Calendars Parameter-POL468.. Parameter-POL . - Image
= [ Trend
M Onine Progress bar
. Achive
| | Cancel |
Figure 165 Parameter Up — and Download
d) Scope Software upload procedure
a) Enable the Loader window by going to: Menu ->View->Loader
[ DefaultLight - Climatix SCOPE Light (Light) - o x
@Menu -] E [ # 1 9 © [J [ iy Disconnect ~ POL45S_0D1939 USB
P Project v > § | % Settings dikix
Recent Projects  » Communication Cument Language
AR ; =S -
: View 4 [:] Startup
S D setngs =
Exit Alarm
" DagoRer | |{}] _Protocol
& @# Data Points Loader
2 Porameter Up- ¢
Wi Mm_ﬁtr&mmm_ﬂli'_
% VWatch Pages Enable or disable loader tab
(5 Sehedulens
€] Calendons
=l Trend
W Orine
g Enable Loader
window
Pratocol - X
£ | Date Level  Infommation Logger A
g' 202207405 12:39.09690  Info Connection State is no con Project
= || 220708 123810213 who Froject saved Progect
5 || 202207405 123510248 ko Froject saved Proect
§ 2022070512:39:11.689 Info Connection State is establs..  Project
20220705 123511704 Infe Connection established Project
20220705 123511.735  Info Application State changed Project
20220705 12:42-30.326 Infio Parameter Parameter-POL Para
20220705 12:43:10.199 Info Parameter Parameter-POL. Para
20220705 12:46:44.582 Info Parameter ‘Parameter-POL. Para
202207405 12:46:55.120 Infio Parameter ParameterPOL. Para v
A bl | Betnmnt [ mtnn
Figure 166 Enable / Disable Loader Window
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(@Mveu- B R0 ™
Project

- 2

5[5 Defautlight
~&% Settings
= g Configuration

~

Communication

Target: | POL46x

Cument Language

Interface: | USB

ing Unit Support

i :E Project
@ Foot Note
& Target
) Time
-~ Diagnostics
=g Data Points

2 Parameter Up- and Download
&% Documentation
- Watch Pages
4Py Schedulers
4] Calendars

enable
UsB
Export Cache Files

| oot |

POL468_0D1939 v

Device:
Software files
Auth: a
window

Fles | BSP | AuoUpgrade |

Message

GUID

Target GUID
A6B19093-3DAT-4EB0-8AA3-3ECAZAFSCOCC
BC7BB6AQ-20D5-4393-A7BC-EB48521FSFEF
A931ADC1-837A-4372-BOB2-E114EFCBRE T
18DID0E3-BC2B-44F3-9B59-57A43071E1FD

File:

MBRTCode ucf
HMicomp uck
OBHVNcomp ucf
HMI4Web.uct
BACnet csv
ScopeConfig ucf

5| Type Time

E 4 Application
| CJ HMICrf Comp
= | CJ MappingComp

[ HMIdWeb
= [] BACnet Client
. [ Light-Version-...

Loader Control
button

TB277C61-411E-4543-A531-156C84118E56

A\ Ham | @ Pmlnml!@ Loader E’

Figure 167 Loader Window

b) Double click on the first raw in the Loader Window
The Browse window will appear
c) Copy the output folder address to be able to create a shortcut of this folder on the desktop. In this folder
we need to copy the Software files later.
K DefaultLight - Climatix SCOPE Light (Light) - ] X
(f@menu - |H [ 2|9 © |[J ldl i§p Disconnect - POL46B_OD1939 USE
Project v B | % Settings b x
a E DefaultLight ||| Communication Cument Language
G e T RO T S o«
[ Project Itefoce: [USB | Ew \SBT\Rar Lo Oupst_|
- Files Modified Size
use ATLAS_4.03A_Code_687ucf 20220304 07:44.16 44DKB

POL468_0D1933 ~

2)Copy the
output folder

Double click
one of the six

ab
J|
[ HMICrf-Comp
[ Mapping-Comp  OBHVNcomp.uck A931ADC1-837A-4372-B0B2-E114EFCBBET1
[] HMIWeb HMI4Web ucf 18D9DOE3-BC2B-44F3-9B59-57A43071E1FD
[ BACnet Client  BACnet csv .
[ Light-Version-... ScopeConfig uck TB277C61-411E-4543-A531-156C84118E56
Load Cancel
A Ao | @ Pretocol | @ Loader |
Figure 168 Copy the Output folder address
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Open the file explorer on your computer and paste the Output folder address in the address bar

[m] X
Home Condividi Visualizza q
- v 4 IC:\Users\andrei.balan\AppData\Local\SBT\RainbowScope\DefaultLight\Output] v I (9] S Cerca in Output
& OneDrive - Daikin Applied Eutope $p.2 A Nome B Ultima modifica Tipo Dimensione
 Questo PC [1] PEGASO_1.16.A Codeuct 04/03/2022 07:44 File UCF #0KB
W Apple iPhone D PEGASO_1.16.4_HMI.ucf 02/03/2022 09:08 File UCF 82KB
Il Desktop || PEGASO_1.16.4_OBHVN.ucf 02/03/2022 09:00 File UCF 76 KB
{4 Documenti [7) PEGASO_1.16.4_Scope.ucf 23/12/2020 16:22 File UCF 30 KB
& Download [7] PEGASO_1.16.4_Web,ucf 02/03/2022 09:08 File UCF 365K8
B Immagini [} POL46xSTD_BSP_Vv1140.UCF 5/05/2019 18:27 File UCF 3.043 KB
& Musica
B Oggetti 30
B video
25 Disco locale (C) Paste the Output folder
@ Rete address on the address bar
of the File Explorer
v

6 elementi

Figure 169 Paste the Output folder address in the address bar of the File Explorer

e) Create a shortcut of the Output folder on your desktop

¥ 1 v | Output
Home  Condwdi  Visuakaza
v 1 1 = Utenti > andreibalan
@ OneDrive - Daikin Applied Europe S.p.a

% Questo PC
¥ Apple iPhone
I Desktop
4 Documenti
& Download
& immagini
D Musica
2 Oggetti 30
B video
L Disco locale (C)

@ Rete

6 elementi

? AppData >

Local » SBT >

Nome
| PEGASO_1.16.A_Code.uct

") PEGASO_1.16.A_HMl.ucf
[ PEGASO_1.16.A_OBHVN.ucf
[7) PEGASO_1.16.A_Scope.uct
|_| PEGASO_1.16.A_Web,ucf
[7] POL46xSTD_BSP_V1140.UCF

Drag And Drop the Output
folder to create a shortcut
of this folder on Your
widows desktop

Figure 170 Create Output folder shortcut

f)  Open the shortcut of the output folder from desktop. Make sure to delete all existing files and copy in this
folder only the unzipped files of the software you need to update on the Siemens Controller.
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g) From Scope Light Loader Control window select now the files to be updated on the Siemens Controller:
Double Click on the raw of Loader window and when the browse window appear, select the file

[ pefaultlight - Climatix SCOPE Light (Light) - 0o X
(@@Menu - | [ (#|9 © ||J i e Disconnect ~ POL463_0D1939 USB
Project ~ & i Settings 4bx
&[5 Defautlight ||| Communication Cument Language
& Settin T POL46x | | | |
5 ; Cw:fwm st ‘ = [ Browse for Application - [u} ®
"I Promct Inteface: | USB Yl E T T
@ Foot Note Fles Sae
2 ii Taget use ATLAS_4.03A Code_687uct 20220304 07:44:16 440KE
F (P Time
L. Diagnostics
- Data Poirts Device: | POL468_001939 v
i 4% Parameter Up-and Download
; \F-‘ Documentation
Watch Pages 13 Double click 2) Select the
L‘ Schedulers . it :
& Gt 9n Application Application file

" Fies | BSP | Auto Upgrade ‘ ab

Type File Time GUID

| =] Application MBRTCodeucf - - ABB13093-3DA7-4EBD-8AA3-3ECA2AFBCOCC

[ HMICrf-Comp  HMIcomp uef - - BC7BBSAQ-20D5-4393-A7BC-EB48521F5FEF

[] MappingComp  OBHVNcomp.uef - - A931A0C1-8374-4372-B0B2-E114EFCEBETT

[ HMi4Web HMI4Web ucf - - 18D9D0E3-BC2B-44F3-9B59-57A43071E1FD

[ BACnet Client  BACnet.csv - - -

[ Ught-Version-.. ScopeCorfigucf - - TB2Z77C61-411E-4543-A531-156C84118E56
Load Cancel

A Ham | @) Protocol | @8 Loader |

Figure 171 Select software files

h) Repeat “step g” for all the remaining files: HMI-Cnf-Comp, Mapping-Comp, HMI4Web, Light-Version-
Config except BACnet Client, until all the software files are selected

i)  Before the update can begin, the application on the controller needs to be stopped. To do so the controller
can be updated.
To stop the controller application, go to: Menu - Application-> Stop

E] DefaultLight - Climatix SCOPE (Light)

@Menu~| 2 9 ™ L) L §o Disconnect ~ poL468 0D1939 USB
M Project > v R .'.'I Settings
[ Recent Projects  » Communication Cument Language
I Application » I O Start Torget: | POL4&x v| | Appication b4
— , [0 Sep intedace: | USB v ¢ 25
© Hep » | \\M?M\ i enable s
Stop applica n target system
B Exit Export Cache Files
- Data Points
& Parameter Up- and Download
{# % Documentation
% Watch Pages
(D Scheduers top the application on the
@ Calendars Siemens controller
= Trend
B Oniine

Figure 172 Stop controller application
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INFORMATION
The controller enters in software update mode: the display will be OFF and the BSP led Orange

30.59+0.1 101.150.2
3/ | i
~
o | oo ) o
< = e
ilo
o] H
| @
()
@ | 4]
oo ml
! .
5.260.1 | 17.73+0.1 139.3£0.2 S S
N A s ¥ 5
9.06+0.1 249+0.3 9 g
a
<

Figure 173 Controller in Software update mode

j) If the Connection to device has been lost! Window appears, press OK and recconect again to the
controller.

Climatix SCOPE

) 9 Connection to device has been lost!
|l |

Show this message again

Figure 174 Connection lost warning

INFORMATION
After the application stops on the controller, this could result unavailable on the Scope Light
Application, and it could be necessary to disconnect and reconnect the USB cable until the

controller becomes again available and is possible to reconnect by clicking on the Connect
button.
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: § Connect - - USB Connection to device has been lost!

] —_—
—

Unplug and recconect the USB until
the controller is again available

: i Connect ~ [Je]EGEFyEED + USB Connection to device has been lost!

Figure 175 Controller not available

k) Once reconnected, a warning window will reappear to let you know that the application has been stopped
on the target (controller). Acknowledge this warning by pressing OK.

Project X

e Application on target stopped or not loaded.

Figure 176 Application stopped warning

I) It's possible now to start software update by clicking on the “Load” button on the loader control window.

Files | BSP |
Type Fle Time GUID Target GLIB Message
[ Appiication PEGASO_1.16.A_Code.ucf 20220304 07:44:16 FAD0ADCD-23A2-42AE ...
4 HMICrf-Comp PEGASO_1.16.A_HMl.uct 20220302 09:08:14 sasciospes8145c29 (- Start Software u pd ate
[ Mapping Comp PEGASO_1.16.A_OBHVN ucf 2022-03-02 09:00:54 2DDFB21D-D707-4708-.. -
] HMI4web PEGASO_1.16 A_Web ucf 20220302 09:08:26 DOTCF41A-447E49ED-..
[ BACnet Client BACnhet cev - -
4] Light-Version Config PEGASO_1.16.A_Scope.ucf

Figure 177 Start Software Update

m) The software update is completed when on the Message column all the voices show “completed”

DAIKIN APPLIED EUROPE S.p.A.

Societa unipersonale soggetta ad attivita di direzione e coordinamento di Daikin Industries Ltd

Sede Legale/Operativa: Sede Operativa: Sede Operativa: 5
Via Piani di S. Maria, 72 Via Giuseppe di Vittorio, 8 Via Giuseppe Ferrari, 31/33 )
00072 Ariccia (Roma), Italia 20090 Caleppio di Settala (Milano), Italia 36100 Vicenza, Italia

T +3906937311 Cap.soc. € 10.000.000,00 i.v. R. 1. RM/ C.F. 04878860586

F +39069374014 PEC: dae@pec.daikinapplied.eu R.E.A. 467651 - P.1. 01318801006 93


mailto:dae@pec.daikinapplied.eu

P"DAIKIN

Fies | BSP |

Type File Time GUID Target GUID

Application PEGAS0_1.16.A_Code ucf 2022-03-04 07:44:16 FAD04DCD-23A2-428E-.. - Completed
[ HMICrf-Comp PEGASO_1.16.A_HMI uct 2022-03-02 09:08:14 9ASC105D-64B1-45C39.. - Software update Completed
A Mapping-Comp PEGASO_1.16.A_OBHVN ucf 2022-03-02 09:00:54 20DFB21D-DT07-47DB-... - P Completed
HMidweb PEGASO_1.16.A_Web.ucf 2220302090826 DOICF41A447CH9ED-. - Completed Completed
[ BACnet Client BACnet csv . . -

(4 Light-Version-Corfig PEGAS0_1.16.A_Scope ucf 2020-12-23 16:22:28 DES6FAC2-411A4C58-A... - Completed

Load Cancel

Figure 178 Software update completed

n) Restart the application on the controller by selecting Menu - Application > Start

K] DefaultLight - Climatix SCOPE (Light)

@ Menu - | B 9 ™ [ Il §o Disconnect ~ POL468 0D1939 USB
Project »
Recent Projects » ]
| Application » ||.ﬁ. Start ""l Application v
View » |© Stop \ v e Ut
© Hep b | Start apphcat\q\n{:n target system i »
B Exit

Device: POL468_0D1939

Auth:

Start Target Application

Figure 179 Start Target Application
0) Once the software upload has completed and the controller restarted, check in the About Chiller menu
that the actual software version corresponds to the one just installed. In case the software version does

not correspond, check that you have the correct software version for the controller copied on the output
folder repeat the software update procedure.
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Figure 180 About Chiller menu
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p) Once the software is successfully updated, it is possible to restore the parameters on the controller.

e) Scope Parameter Restore procedure

a)

From the Project page click on the Parameter Up- and Download

b) Step 1) Select the option All object interface with all members

c)

Step 2) Select the desired parameter file

d) Step 3) Click on the PC>Target button and confirm the parameter upload
Parameter upload procedure finishes when the progress bar arrives at 100% and disappears

e)

[ Defauntignt - Climatix SCOPE (Light) = o ®
@Menu~ B ) |9 ™ |l i §g Disconnect - POL463 0D1939 USB
Project = B % Setings 7 Porameter Load" 4bx
= a DefmltLiht Parameter Loading
& Setings Restore Selection = >

& @ Cofiguration O Alinstances wth mandatory members L Step 3) Start Parameter upload into SR
f_"fh‘:“m ® Alobjectntances wth al merben the controller

o Il Taget O°"“_"'""_""""" )
QL'TM - Step 1) Select All object interface

@ Data Ports with all members
2 Perameter Up- and Downioad
£3 Documentation
Watch Pages

B Schecders Descrption Fie Time Tyve
€. Calendan Paramater ParameterPOL.. 20220403 .. Image

-l Trend parameter 2 PaameePOt 0224

parameter 3 2
: m Step 2) Select the desired parameter Progress bar
files
7
I |
Figure 181 Parameters upload procedure
f)  Recycle the controller by removing the power supply or select "Apply changes" in menu Commission Unit
- Configuration - Unit &> Apply Changes = YES to restore actively the parameters.
g) Since the parameter update is done in 2 stages, it is necessary to repeat the Parameter Restore
procedure twice
h) The Software update and Parameters restore procedure are completed.
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INFORMATION
ﬂl In case the restore procedure fails, all the parameters are set as default.
So, unit, circuit configuration, alarm limits, sensor calibration, compressor run hours and starts,

frequency parameters are anyway possible to update manually.
In case parameters are lost, refer to service support for correct unit configuration.

CAUTION
To double check the parameters already copied, verify each setting according to the Manual
Configuration procedure

9 Scope Light — connection by ethernet cable

If you prefer to connect to scope via an ethernet cable, follow this procedure.

9.1 Configure the TCP/IP properties of the ethernet card of the laptop

INFORMATION

E] Be aware if the chiller controller uses different IP address than the standard one to change in
Scope the host address. In order to make communication possible with the build in Ethernet card
of the laptop, the TCP/IP properties of the card will need to be customized. Administrator rights
maybe required for this procedure

a) Select via Window start button the Control Panel and then select the LAN local area connection type

Al Apps Documents G More ¥

Best match

Control Panel G
App [

Apps
Control Panel
3F Settings App

Search work and web

P control panel - See work and web results >

Settings (4)
Recent
52 Network and Sharing Center
Internet Options
Visualizza attivita e stato della rete
> Power Options
App consentite

Disinstalla un programma

£ control panel

“ M o 7 3 w ph &

Figure 182 Control Panel, Start MENU
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5% Metwork and Sharing Center

Control Panel Home

Change adspter settings

Change advanced sharing
settings

Media streaming options

Sesalso
Internet Options

Windows Defender Firewall

“ v A :.5 » Control Panel » Network and Internet » Network and Sharing Center ~ (<]

View your basic network information and set up connections

View your active networks

daikinapplied.eu
Domain netwark

Access type: Internet
Connections: [ Ethernet 4

Change your networking settings
ik Set up a new connection or network

Set up a broadband, dial-up, or VPN connection; or set up a router or access point.

[ Troubleshoot problems

Diagnose and repair network problems, o get troubleshooting information.

Figure 183 Control Panel, Network and Sharing Center

b) Apply below example for the TCP/IP protocol, these will ensure to establish the communication with the
controller. The Ethernet cable is connected on the T-IP port of the controller.

[ Ethernet 4 Status

General
Connection
IPv4 Connectivity: Internet
IPv6 Connectivity: No network access
Media State: Enabled
Duration: 00:20:10
Speed: 1.0 Gbps
Activity
Received
Bytes: 3,743,402 | 2,585,090
OProperb’es QDisable Diagnose
Close

Networking ~ Sharing

Connect using:
¥ Intel(R) Ethemet Connection (3) 1218-LM

This connection uses the following items:

V] B3 Client per reti Microsoft A
[ ? Condivisione file e stampanti per reti Microsoft
Lkilta di pianficazione pacchetti QoS
V| 4 Protocollo Intemet versione 4 (TCP/IPv4)
] & Protocollo M'isoft Network Adapter Muttiplexor

| s Driver prot LDP Microsoft
W 4 Protocollo versione 6 (TCP/IPv6) v
< >

Description
TCP/IP. Protocollo predefinito per le WAN che p: la

comunicazione tra diverse reti interconnesse.

Install Uninstall

OK Cancel

General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(O Obtain an IP address automatically

(® Use the following IP address:

1P address: v . :
Subnet mask: I@
Default gateway: I:]

Obtain DNS server address automatically

(@) Use the following DNS server addresses:

Preferred DNS server: :]
[[Jvalidate settings upon exit

Advanced...

5] o

Figure 184 Ethernet Properties

c) Connect the Ethernet cable from the laptop to the controller
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Figure 185 ETHERNET Cable

POL 688

| R

DAIKIN APPLIED EUROPE S.p.A.

POL 468

POL 638

R 222222222222 2A PAA |SZ£'U‘_\Z‘Z£_£Q E(‘i
— J

R I I I I R R ER T ER TN

S E] R

=T @@ju—l@

POL 687

RSA|RIEASERY REIRREIRIRSI AN

= ﬁnﬁnﬁnﬂﬁ

Figure 186 Ethernet connection cable
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a) Scope light connection

a) Go to the Settings Tab:

B DefaultLight - Climatix SCOPE (Light)
(@@Menu - | [ 89 & |LJ ¥ § Connect ~ POL687093388
o2 Settings ‘E Startup

« y SIE

v USB

Figure 187 Settings Window

b) From the Target dropdown window select the controller you intend to use (POL 688, POL 687, POL 638,
POL 468)
c) From the Interface dropdown window select TCP/IP
d) Inthe Host text box write 192.168.1.42
e) Inthe Port text box write 4242
f)  Click on the Save All Tabs to save the current settings.
g) ONLY FOR POL688, In the Auth text box write password: SBTAdmin!
f) Save all tabs
E DefaultLight - Climatix SCOPE Light (Light) — O be
(@Menu - B [ 29 o L g Tonet - 160142 v PR
|FHI!! v B | i Settings | | h) Select the controller b x
aukLi = N e Cu nguage z
N Efojs;ﬂ Target: 1 pOLES = tend to use
o i E
- @ Tme || e———======= |
L. Diagnostics
- @ Data Points

@ Parameter Up- and Download
|83, Documentation
- Watch Pages
Schedulers
4| Calendars
- |l Trend
.} Onine
L&l Achive

Host: 1[192.168.1.42 < Rt et e
por: o2z ) T ) Insert 192.168.1.42
. [ﬁt\

e) Insert 4242

Figure 188 Communication settings

INFORMATION

Once the cable is connected, automatically the Siemens controller drivers are installed on the
PC. This operation usually takes just a couple of seconds. When driver installation is done, the
POL device becomes available in the Device dropdown menu.
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h)  Click on the Connect Button
i) Put the Daikin Service Password when asked for the PIN
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Figure 189 Scope Ethernet connection

INFORMATION
ﬂl On board controller: when connecting controller, parameters are read by Scope Light. Before
proceeding with any action on Scope Light, the parameter reading process must be completed.

il Browser [ i\ Alam | 0 Protocol | [@d Loades

Figure 190 Scope reading parameters

You have successfully connected Scope Light to the controller, now you are able to proceed with “Save Parameters”,
“Software Upload” and “Parameter Restore” procedure

Refer to previous paragraphs
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10 Save/Restore menu string table

Function to download Function to download ?;g‘g;ﬁoizd;tgczu nsc(;if(t)vcae:\éalijlsaizle
Model Software “PARAM.UCF” file from “PARAM.UCF” file from SD to strin “Softwari Update” in 9
controller to SD/USB controller Sg P
ave/Restore menu
EWAQ~G ) ) .
EWYQ-G GIZzMO "Save to File (Yes)" "Rstr from file" Not Available
EWAQ-~E/F ACZC “Save to File” “Rstr from file” Not Available
EWYQ~F ACZ-H "Save to File (Yes)" "Rstr from file" Not Available
EWAD-~E
EWAD~D MNG "Save to File (Yes)" "Rstr from file" Not Available
ERAD-~E
EWAD~C
EWAD~CZ AWS "Save to SD" "Rstr from SD" Not Available
EWAD~CF
EWAD~TZ
EWAH~TZ
EWAD~TZ B
ATLAS “Save Parameters” “Restore Parameters” Available
EWAH~TZ B
EWAD~TZ C
EWAH~TZ C
EWAD~T B
MNG* "Save to File (Yes)" "Rstr from file" Not Available
EWAD-~T
EWAD-T C AWS* "Save to SD" "Rstr from SD" Not Available
EWAT~B B NASH “Save Parameters” “Restore Parameters” Available
EWYT~B B NASH_HP “Save Parameters” “Restore Parameters” Available
EWWQ~G
EWHQ~G
EWLQ~G WaterStream "Save to File (Yes)" "Rstr from file" Not Available
EWLQ-~L
EWWQ-~L
EWWD~J
EWWD~G
EWWD~I
EWWD "Save to File (Yes)" "Rstr from file" Not Available
EWLD~I
EWLD-J
EWWQ-~B
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PFS_3.30.A
EWWD~H "Save to File (Yes)" Not Available Not Available
Only POL 687
EWWD~VZ
EWWH~VZ ADAM "Save to SD (Yes)" "Rstr From SD" Not Available
EWWS~VZ
EWYD~4Z
EVE “Save Parameters” “Restore Parameters” Available
EWYH~4Z
D-AHU Modular Mod_Airstream “Save Params” “Load from SD” Not Available
D-AHU Professional Pro_Airstream “Save Params” “Load from SD” Not Available
AHU Digital D-Stream “Save Params” “Load from SD” Not Available
Modular Light Siemens Evolve “Settings save -> SD” “Settings load <- SD” Not Available
EWAT~CZ
PEGASO “Save Parameter” “Restore Parameter” Available
EWYT~CZ
EWWQ~KC NaYda “Save Parameter” “Restore Parameter” Available
EWAD~TZ D
EWAH~TZ D
EWAS~TZ D ETRA “Save Parameter” “Restore Parameter” Available
EWAD~MZ D
EWAH~MZ D
EWAT~B C ARES “Save Parameter” “Restore Parameter” Available
INFORMATION

AWS and MNG software are compatible for different compressors model, before installing the
software check the compressor model.

MNG Software: HSx3118, HSx3120, HSx3122

AWS Software: HSx192, HSx204, HSx215, HSx232, HSx263, HSx269, HSx241
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